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About Output Server 2
Output Server 2 is Grass Valley’s next generation video playout engine for iTX systems. It 
has improved standards compliance, more flexibility and greater stability than our previous 
video engine and forms the backbone of the iTX system.

This guide describes the features and functionality of Output Server 2 (OS2), as well as the 
underlying principles of Output Server 2. It also explains how to install or upgrade to 
Output Server 2, how to create and configure channels using Output Server 2 and provides 
information about the day-to-day operation and maintenance of an Output Server 2 
channel.
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About the Output Server 2 Services
Output Server 2 is a combination of services that work together to form the video engine 
that is responsible for the playout of a television channel. 

The core services that make up the Output Server 2 system are:
• TXPlay 2 - schedule automation controller

An instance of the TXPlay 2 service runs for every channel in the iTX system. Each one 
allows users to interact with and control the playout of each channel’s schedule playlist.
Additional instances of TXPlay 2 can be run that act as “edit channels”, which can be 
used for off-air schedule manipulation. A special instance can also be run in “live 
channel” mode, which can send alternative playout commands for ad hoc operations.

• Output Server 2 service - playout communication and command interface
An instance of the Output Server 2 service runs for every channel in the iTX system. 
Each one provides the communications interface for receiving playout commands for 
the channel, either from TXPlay 2 or directly via specific iTX Desktop components. The 
Output Server 2 service also performs media transfers for caching operations, as 
instructed by the Media Cache 2 service. 
Supporting Output Server 2 is the File Processing Pipeline, which is the media 
application framework plugin that performs all video, audio and ancillary data 
processing operations. The operations have been separated into two processes to 
allow the video engine to be reinitialized without the overhead of also re-initializing 
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the network communications, allowing faster recovery from video/audio processing 
issues.

• I/O Device Controller - AJA video/audio I/O card interface
The I/O Device Controller service manages the configuration of the ports on the 
playout server’s video and audio input/output card(s). It receives this configuration 
from TXPlay 2 on start up and then interfaces between the video/audio I/O card and 
the Output Server 2 service. It is also used to specify the input reference signal, frame 
rate family and the output timing for the channel.
Only one instance of the I/O Device Controller is required per playout server.

• Media Cache 2 - file caching mechanism
The Media Cache 2 service manages all caching operations required for playout from 
the local machine. It also provides a channel view so that the current file caching queue 
can be monitored from within iTX Desktop. The actual media transfer is performed by 
the Output Server 2 service, which can throttle the transfer speed dynamically to 
ensure reliable playout.
A single media cache can be shared by multiple channels running on the same playout 
server.

These services, along with any other components installed on your playout server are 
launched and managed by another application, called the Server Controller. This means to 
start all of these services, you only need to start the Server Controller. See Starting Output 
Server 2 on page 95.

Output Server 2 integrates with the current iTX framework, allowing you to easily upgrade 
your existing channels. Whilst Output Server 2 supersedes the previous video engine, 
Output Server 1 is still supported and it is even possible to run both video engines in the 
same iTX system. See Transitioning to Output Server 2 on page 18.

About iTX Channel Playout

About Output Targets (SDI and IP)
There two methods by which a playout server can send and receive transmission signals:

• Via an SDI (Serial Digital Interface) card, such as the AJA Corvid 88, 
• Over a computer network using IP (Internet Protocol), via a dedicated network adapter.

To maintain clarity through this document, both SDI card and the network adapter being 
using for streaming are referred to as video/audio I/O cards.

It is also possible to use a combination of SDI and IP targets on the same playout server. For 
example, for dual channel playout, one channel could be output to an SDI target, while the 
other could be sent to an IP target. 

Note: To support 4K input and output, 64-bit versions of the Output 
Server 2 service, File Processing Pipeline (FPP) and I/O Device Controller 
are automatically installed when the Output Server 2 is selected for 
install.
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A single channel can even have a combination of up to two output targets (SDI or IP) 
depending on the availability of I/O cards on the system. Output targets allow for different 
branding levels or output quality settings to be used simultaneously on a given channel.

See Creating an Initial Channel During Installation, on page 28 and Configuring Channel 
Playout, on page 45 for instructions on setting and configuring Output Targets.

SDI card support
Output Server 2 supports the following models of SDI video/audio I/O card:

• AJA Kona 3G 
• Single AJA Corvid LP 
• Dual AJA Corvid LP 
• AJA Corvid 44
• AJA Corvid 88

IP Playout Requirements
For IP playout, your iTX system must meet the following requirements:

• To maintain the integrity of the IP playout, the streaming network (used for the IP 
inputs and output) must be independent from the management network (used to 
control the equipment).

• Your playout server must have a minimum of two network adapters — one for the 
streaming network and one for management network.

• The streaming network adapter must have enough bandwidth to support the 
combined bit rates of all your simultaneous live IP inputs and the IP output. 

• The iTX Router Service must be installed and the IP sources and IP destinations 
configured on the iTX Framework Server. See the iTX System Administrator Guide for 
more information about installing and configuring the IP Router Service. 

About Playout Types
A playout type defines which input and output ports on the video/audio I/O card are active 
and require cabling. This dictates what kind of channel can be operated on the playout 
server. For example, the input and output ports required to operate a single channel are 
different to those required to operate dual channels. iTX Output Server 2 supports the 
following playout types:

Single Channel Playout
Single channel playout means the channel has a single input and a single output. This 
playout type can be used for main channels and backup channels running on their own 
playout servers.

Note:
• Although iTX 2.x supports the AJA Kona 3G video/audio I/O card, it does not 

support the AJA Kona 3 card.
3



About Output Server 2
About Playout Types
Single Channel (4K)
iTX supports playout of 4K media encoded as Quad Full HD (QFHD), which has a pixel 
resolution of 3840 x 2160 (four times the resolution of 1080p). 

4K is only supported on AJA Corvid 44 and AJACorvid 88 SDI video/audio I/O cards and has 
the following cabling requirements:

• For 4K output, all four output spigots on the SDI video/audio I/O card must be 
connected to four inputs on a matrix router.

• For 4K input, your playout server must be equipped with a AJA Corvid 88. All four input 
spigots on the Corvid 88 must be connected to four destinations on a matrix router.

• If you are using the iTX CG or Logo plugins, a special environment variable must be 
added to the iTX Desktop PCs that will be used to manage the 4K channels. This 
enables the 4K canvas for creating CG and Logo assets, as opposed to the default HD 
canvas.

Dual Channel Playout
Dual channel playout means there are two independent channels running on a single 
playout server, each with its own inputs and outputs. This can be used to run a main 
channel and the backup of another channel on a single playout server (providing it is 
equipped with a compatible video/audio I/O card).

Dual Live Input
Dual live Input means the channel has two live input sources, but a single output. In an 
Output Server 2 system, both live inputs can be connected to and played out from a single 
playout server (providing it is equipped with a compatible video/audio I/O card). 

Within ITX Desktop, the two live inputs appear on a single channel as program A and 
program B (PGM A and PGM B on the timeline). This allows you to switch between back-to-
back live events using the internal iTX Master Control plugin. See Viewing Live Event Inputs 
on Channel Control Layouts on page 97.

Dual live input also allows for live-to-live cross fade transitions and picture-in-picture (PiP) 
effects, where one input is used for the main display and the other is used for a smaller 
frame with the main display.

The iTX Simulcast Playout also supports the use of Dual Live Inputs, which is configured as 
part of the standard simulcast playout. See Simulcast Playout below.

Simulcast Playout
For simulcast playout, two channels share two inputs, but have independent outputs on 
the playout server (providing it is equipped with a compatible video/audio I/O card). A 
typical use case for a simulcast system is to have one high resolution transmission and one 
lower resolution transmission from a single schedule that is loaded on to the main channel. 
For example, HD as the main channel and SD the simulcast, or 4K as the main channel and 
HD the simulcast. Because the main and simulcast channels have different requirements for 
the resolution, aspect ratio control (ARC) and audio output, the two channels are 
configured independently.

Note: Output Server 2 does not support secondary recording of 4K.
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To transmit appropriate branding for a simulcast channel, iTX allows you to configure event 
substitution rules. Using these rules, iTX is able to swap assets such as logos and CGs based 
on their names in the main channel’s schedule before they go to air. 

iTX manages the broadcasting of main and simulcast channels using a system of 
networked instances of TXPlay 2, known as a leader/follower network. The main channel in 
any iTX system is identified as a leader channel. When a simulcast channel and its 
corresponding backup channels are added to the iTX system, they are designated as 
followers. 

When TXPlay 2 is set to a simulcast playout type, iTX also supports dual live inputs for 
simulcast. As each live feed in a dual live input channel is connected to different input, 
when operating dual live inputs for simulcast, the leader channel selects which input it is 
going to use and informs the follower/s to use the same input.

For more information about the leader/follower model, see About Leader/Follower Channel 
Communication, on page 6.

On-Demand Playout
Unlike the conventional playout types, the On-Demand playout does not permit an output 
to a monitor. Instead, the output generates a master video file from the schedule and also 
transcode, proxy and metadata if needed.

Playout Type Support
The table below shows which playout types are available to each supported model of 
video/audio I/O card:

Playout Type K3G 
1x 

CLP
2x 

CLP C44 C88 IP Comment

Single channel       Default for all models of video/audio I/O 
card. Use for stand alone main or backup 
channels.

Single channel 
(4K)

  Corvid 44 only supports 4K output. For 4K 
input, your playout server must be 
equipped with a Corvid 88.

Dual channel     Select to configure two channels running 
on the same playout server (i.e. channel A 
main and channel B backup).

Simulcast    Select if you are configuring a simulcast 
channel on a separate playout server or 
you are configuring a main channel and a 
simulcast on the same playout server.
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Key:
• K3G is AJA Kona 3G for SDI targets
• CLP is AJA Corvid LP for SDI targets
• C44 is AJA Corvid 44 for SDI targets
• C88 is AJA Corvid 88 for SDI targets
• IP is Internet Protocol playout using a network adapter.

About Leader/Follower Channel Communication 
Output Server 1 communicates between a main channel and its backup using a 
master/slave model. The two channels share the same configuration, schedule, assets and 
iTX Desktop controls, and changes to any of these on the main channel (the master) are 
also sent to the backup channel (the slave). The backup also checks the database every 30 
seconds and changes to the schedule on the main channel cause a schedule restore on the 
backup channel. This results in a delay of up to 30 seconds between schedule changes on 
the main and backup. 

Master/slave operation relies on the status of a single router crosspoint (destination) to 
determine which channel should act as the master. In the event of a failover, the backup 
channel takes over the transmission of the scheduled programming.

Output Server 2 uses a leader/follower model for channel communication. This means the 
main channel is the leader and its backup channel is the follower; in a simulcast system, the 
simulcast channel and its backup channel are also followers. This is known as a 
leader/follower network. When the iTX Desktop operator performs a manual control, 
schedule change or changes an asset, the leader channel passes these changes on to its 
followers and they respond instantaneously. This ensures the channels in the 
leader/follower network are always in sync with each other, regardless of the number of 
followers.

Failovers are controlled in the same way as the master/slave model, however, iTX can only 
promote main and backup channels to be leader channels; simulcast and simulcast backup 
channels can only be followers.

About Logical Audio Programs
For video and voice over media, Output Server 2 provides the ability to define substitution 
rules for audio formats and languages, then apply those rules on a per-channel basis. This is 
achieved through the use of logical audio program labels.

Dual live     Select if you are configuring a single 
channel with two inputs and one output.

On Demand The On-Demand playout type does not 
have an I/O Device Controller service since 
there is no I/O processing occurring 
through the video/audio I/O cards.

Playout Type K3G 
1x 

CLP
2x 

CLP C44 C88 IP Comment
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When video and voice over media is imported via Delivery Manager, the audio track 
configuration and metadata are analyzed and divided into audio programs. Simple audio 
types, such as PCM stereo, PCM mono and Dolby D have just one audio program each, 
while the more complex Dolby E type can hold multiple audio programs (as defined in the 
asset’s metadata). 

Audio programs are given a unique label, which is stored in the iTX Opus database, so that 
it is available across the iTX system. Within the Output Server 2 user interface, you can 
define mapping rules to control the order of preference for applying the known labels to 
the output audio program group, as applied to each physical pair when the media is 
encoded. This is illustrated in Figure 1-1below.

Fig. 1-1: Logical audio programs, brought together as groups along with an encoding method and 
how this relates to physical audio channels on output.

The audio output program groups you create are also associated with the configuration of 
Dolby metadata, upmixing and audio watermarking.

On playout, the operator can see which events have had their audio substituted and can 
override substitutions where necessary. See Managing Audio from iTX Desktop on page 89.

iTX offers two ways of managing media that does not have a matching audio program to 
substitute:

• If no match can be found, the item can be modified from within iTX Desktop. 
See Managing Audio from iTX Desktop on page 89
If no substitution is made, the item will show an error in the Schedule Grid.

• A Silence label can be added to the end of an audio program rule, which tells iTX if no 
match can be found, play out silence. 
Defining Substitution Rules for Audio Programs, on page 56.

Note: Output Server 1 and Output Server 2 (up until iTX v2.8) supported 
PCM (Auto) mode for Audio Mapping. In this mode, the number of channels 
was determined by the source audio stream. Use of the PCM (Auto) output 
format could impact the track positioning of subsequent output streams and 
is not supported for media with logical audio programs.
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About Asset Management for Logical Audio Programs 
Consider the following points about how Output Server 2 handles assets for logical audio 
programs:

• Video and voice over assets ingested prior to iTX 2.8 will not include logical audio 
programs and must therefore be updated using the Asset Fixer Service. 
See Update Existing Assets to Use Logical Audio Programs on page 15.

• For audio programs to be extracted from new video assets by Delivery Manager, your 
iTX system must be configured to register video file types using the File Processing 
Pipeline (FPP). 
See Media Import Configuration Tool in the iTX System Administration Guide.

• By default, iTX groups mono tracks on import to create stereo programs. This behavior 
can be changed within the Delivery Manager configuration. 
See Separating Mono Tracks on Import on page 102.

• By default, iTX ignores language metadata on import. This behavior can be changed 
within the Delivery Manager configuration. 
See Including Language Metadata on Import on page 102.

• As live events are not analyzed by FPP, they must have their audio program groups 
defined on a per asset basis. This is performed from the Property Editor, within the iTX 
Desktop Asset layout.
See Adding logical audio programs and groups to live assets on page 66.

Upgrading from Output Server 1 to Output Server 2
iTX allows broadcasters to transition from an Output Server 1 system to an Output Server 2 
system by running both video engines in parallel within the same iTX system during the 
upgrade. This is known as a “mixed Output Server system” and is only recommended 
during the upgrade and testing process, and not for prolonged day-to-day operation.

For more information see the iTX Output Server 1 to Output Server 2 Playout Server Migration 
Guide.
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Known limitations of Output Server 2
Output Server 2 has the following known limitations:

• Automatic Loudness Control (ALC) is currently not supported and set to Off by default 
in the Output Server 2 Configuration panel. Support for this feature will be added in a 
future release.

• Output Server 2 does not currently support regional sub-channels. This functionality 
will be added in a future release.

• Output Server 2 does not currently support news flash. This functionality will be added 
in a future release.

• Raw audio mode is not supported for MPEG audio codecs.
• When using Dolby E (Auto) output, Dolby Metadata is not supported.
• Squeeze effects are not supported for CGs or logos in either Output Server 2 or Output 

Server 1.

Output Server 2 does not allow both split breaks and opt-out breaks to be used together in 
regional channel playout.
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Preparing for Output Server 2
This chapter discusses the hardware and software prerequisites for operating an Output 
Server 2 iTX system, including the additional licenses that may be required. It also provides 
an overview of the installation process for new iTX systems and upgrades from Output 
Server 1.

Summary
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Prerequisites and Compatibility Requirements
Output Server 2 has both hardware and software prerequisites that must be met before the 
module is installed.

Required Software and Driver Versions

Software Requirement

AJA video/audio I/O 
video card driver 
version

Output Server 2 requires AJA video card driver version 12.3.13.117 to 
be installed via Windows Device Manager before installing or 
upgrading iTX. 
If you have previously installed Output Server 1, the version 7.4.0.49 
AJA drivers must be uninstalled and deleted from Device Manager 
before installing the latest drivers. 

IMPORTANT:
Do not use drivers that are supplied with your AJA video/audio I/O 
card or any that have been downloaded from the AJA website. The 
required drivers for iTX are specially supplied by AJA and are included 
with the iTX Suite in the Drivers folder.

Framework 
component version

Your playout server and framework server must be running the same 
version of their respective iTX components for Output Server 2 to 
function.

Vertigo Suite version If you are using Vertigo XG graphics, Output Server 2 requires Vertigo 
Suite v5.0 SP1 or later. 
If you have purchased the Vertigo Suite and require the installation 
software, contact Grass Valley Product Support. For more details visit: 
http://www.grassvalley.com/support/contact.
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Required System Configuration

License Requirements
The modules that make up the iTX system are individually licensed and add-on 
components (such as XG Inside) require their own license to function. 

Depending on your system architecture, the following licenses may be required to operate 
Output Server 2:

Licenses are stored in .lic files and require a Grass Valley license dongle to be inserted into 
a USB port on the playout server. For more information about purchasing software licenses 
and the Grass Valley license dongle, please contact: itxlicensing@grassvalley.com.

Registering an iTX license file
To register a new license it must be imported via the System Service, which provides access 
to configuration data and system management and runs on your iTX Framework Server.

Feature Requirement

Media registration 
method

Set the Media Import Configuration Tool to use FPP as the global 
import override for all of your video file types.
See Setting the Media Import Overrides to File Processing Pipeline on 
page 15.

Dual channel playout To transmit dual channel or simulcast broadcasts, your playout server 
needs the following:
• For output to SDI targets: an AJA Corvid 44 or Corvid 88 video/audio I/O card 
• For output to IP targets: either a networking adapter dedicated to the 

streaming network or a multi-port network adapter (from iTX v2.8 onwards).
• The I/O Device Controller service (available from iTX v2.6 onwards).

Simulcast playout

Vertigo XG Inside When XG Inside is enabled, Remote Desktop must be disabled on the 
playout server.

Component/feature Required license

Video playback on Output Server 2 via 
the File Processing Pipeline plugin

FPP Playout

Vertigo XG Inside graphics iTX Integrated XG graphics

IP Playout (2022-2) • IP Input (Live events from IP sources can be scheduled and 
played to air)

• IP Output (Broadcast channel playout over IP using SMPTE 
2022-2)

• x264 Encoder(x264 AVC video encoder)

4K inputs and outputs 4K playout

Dolby metadata Dolby

Nielsen audio watermarking Nielsen

Voice overs Voice Over

Simulcast Simulcast
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To import a license file using the System Service:
1 On your framework service, open and expand the System Service.
2 Click on the Licensing tab.
3 Click the License Details tab.
4 Click Import License.

The Import License File… browse window appears.
5 Browse to the directory containing your .lic license file.
6 Select the license file and click Open.

The license file is registered and appended to the list of licenses on the Licence Details 
tab.

7 When an updated version of an existing license file is imported, services (such as 
TX Play on playout servers), must be restarted to ensure they reflect the updated 
license. 
When TXPlay 2 restarts it will check that the required licenses have been installed. The 
status of the licenses can be checked by running diagnostics on TXPlay 2.

Process Overview - Output Server 2 Installation and Channel 
Configuration

The process of installing Output Server 2 and configuring a channel consists of the 
following actions:

1 Install the required licenses and drivers. 
See Prerequisites and Compatibility Requirements on page 11.

2 Install the Output Server 2 module on your playout server. 
See Installing Output Server 2 on page 19.

3 Add your first channel, followed by any subsequent channels. 
See Adding Channels to an ITX Playout Server on page 25.

4 Start Server Controller to launch Output Server 2 and its related services. 
See Starting Output Server 2 on page 99.

5 Configure the routing and communication model for the channel. This involves the 
following steps:

a Route the SDI channel sources to matrix destinations.
b Configure the channel communication setup.
c If you have a simulcast channel, define an Event Substitution Rule.

See About Channel Communication and Routing on page 35.
6 (Optional) IP Playout: Configure the IP routing and playout settings. This involves the 

following steps:
a Assign IP Router Matrix Destinations to the channel inputs.
b Configure the channel’s IP output settings.

Note: If you have purchased a Grass Valley Playout Appliance 2 it will come 
pre-installed with Output Server 2.
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See About Channel Communication and Routing on page 35
7 Configure the basic channel playout settings. This involves the following steps:

a Set a Reference source and Frame Rate Family, and adjust the output timing (if 
required). 

b Configure the timecode settings.
c Configure the Active Format Description Insertion Lines.
d Configure channel delay, if required.

See Configuring Channel Playout on page 45.
8 Configure your channel to process splice insert messages. There are two ways to 

configure this:
• Using the legacy VANC plugin
• Using the enhanced SCTE104 plugin

See Configuring Splice Insert Processing on page 69.
9 Configure any additional plugins or functionality you have licensed. This involves the 

following steps:
a Configure Softel Inside for subtitle playout. 
b Select the channel to use for XG Inside graphics. 
c Define custom Aspect Ratio Control (ARC) modes.

See Configuring Optional Plugins and Functionality on page 75.
10 (Upgrades from iTX v2.7 or earlier) Update your existing live assets, media and 

registration rules to support logical audio program groups before configuring your 
audio setup in Output Server 2. This involves the following steps:

a Set the media registration method to FPP for deep analysis. This is required to 
extract audio program labels from media as it is imported via Delivery Manager.

b Convert existing media and live assets to the logical audio program model using 
the Job Service Manager Asset Fixer plugin.

See Preparing for Logical Audio Programs on page 15.
11 Configure how audio within video and audio files is registered in Delivery Manager.

See Configure Your Delivery Manager Endpoint on page 15.
12 (New installations) Import media to populate your Opus database with your audio 

program labels. 
13 Configure the audio output and substitution using the audio program labels extracted 

from your updated or recently imported assets. This involves the following steps:
a Map substitution rules to audio programs.
b Configure the audio watermarking, such as Nielsen for each audio program being 

used.
c Configure Dolby metadata for each audio program being used.
d If required, configure audio upmixing, for each audio program being used.
e Assign audio program to audio output program groups.
f Map stereo voice overs to Dolby 5.1 outputs.

See Configuring Audio Output on page 53.
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14 If you have created a 4K channel and will be using the iTX CG or Logo plugins, you must 
also add the 4K Desktop environment variable to all of the iTX Desktop PCs that will be 
used to control the channel. 
See Configuring iTX Desktop for 4K CGs and Logos on page 72.

Preparing for Logical Audio Programs
iTX 2.8 introduces the logical audio programs model for handling audio output and 
substitution. This fundamentally changes how video and voice over assets need to be 
imported, so that their audio program labels are extracted and registered in your Opus 
database. As such, you need to change how new video and voice over assets are registered 
and also update your existing assets to ascertain their audio program labels.

Setting the Media Import Overrides to File Processing Pipeline
So that Delivery Manager can extract audio program labels from video and voice over 
assets and register them in the Opus database on import, the Media Import Configuration 
Tool needs to be configured to use the File Processing Pipeline (FPP) as the global import 
override for all of your video file types. This provides deep analysis of the metadata in your 
video and voice over media when they are imported.

For more information on installing and configuring the Media Import Configuration Tool, 
see section Media Import Configuration Tool in the iTX System Administration Guide.

Configure Your Delivery Manager Endpoint
The Delivery Manager Config includes two options for controlling how the audio within 
media files is registered in the Opus database. Those options are:

• Group Mono Tracks
When checked (default), this option combines mono tracks to create PCM stereo 
programs on import.

• Ignore Language Metadata
When checked (default), this option tells Delivery Manager to exclude any audio 
program language labels within the media (e.g. language tags) and use the default 
labels instead (i.e. P#1, P#2, etc).

These options are available to all endpoint types and need to be configured for each 
endpoint individually. They are also available within the iTX Asset Fixer job service for 
existing assets that require updating to the logical audio program model.

For more information on creating and configuring Delivery Manager endpoints see iTX 
Delivery Manager Setup and Configuration Guide.

Update Existing Assets to Use Logical Audio Programs
Any videos, voice overs or live assets added to your database prior to iTX v2.8 will not 
include logical audio programs. However, iTX includes a Job Service Manager plugin called 
Asset Fixer, which can be used to update these assets to use the logical audio programs 
model. The Asset Fixer performs a shallow analysis of all media on the media store, without 
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performing a de-archive action. This means the size of your media does not affect the 
duration of the fixer job, only the quantity of files on the media store.

Install and Configure the Asset Fixer Service
The Asset Fixer Service must be installed on the database server, along with the Job Service 
Manager. 

Within the Job Service Manager Configuration, the options for setting logical audio 
programs mirror those of the Delivery Manager endpoint.

To install and configure the Asset Fixer Service:
1 Access and open the iTX Installer.
2 Right-click the Setup.exe file and select Run as administrator. 

The iTX Select Software to Install window appears.
3 Expand the Content Management > FPP Job Service section
4 Check the following components:

• Job Service Manager (if not checked already)
• Asset Fixer JSM Plugin
• Asset Fixer JSM Plugin Config

5 Click OK.
The Select Software to Install window closes. 

6 On the iTX Installer window, click CONTINUE.
The selected components install.

7 Before the installation completes, the Job Service Manager Configuration dialog 
appears.

8 In the Set Logical Audio tab, the Job Service Details section should not be changed.
9 In the Configuration section, set the following values, as required:

a Group Mono Tracks - When checked (default), this option combines mono tracks 
to create PCM stereo programs on import.

Note: If you are migrating from Output Server 1, updated assets will 
continue to playout using its existing physical audio mapping.
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b Ignore Language Metadata - When checked (default), this option tells Delivery 
Manager to exclude any audio program language labels within the media (e.g. 
language tags) and use the default labels instead (i.e. P#1, P#2, etc).

10 Click Save.
11 Restart the database server for the changes to take affect.

Update existing media to use logical audio programs
Once installed, the Asset Fixer plugin appears as an additional service on the database 
service. Unlike other services, the asset update jobs performed by the Asset Fixer Service 
need to be manually triggered.

Once started, the Asset Fixer Service updates all video assets as one job, then updates all 
voice over assets as a second job and finally updates live assets as a third job. 

To update existing media to the logical audio program model:
1 On the database server, expand the Asset Fixer Service.

The Asset Fixer Service user interface appears.
2 Click on the Configuration tab.

The Job Service Details dialog appears.
3 Click Update Assets.
4 The Asset Fixer Service begins processing your existing assets.

Viewing Asset Fixer job progress
Asset Fixer jobs appear in the Job Monitoring layout, along with other workflow jobs. The 
Job Monitor layout includes Type filters to show either the video asset update jobs or the 
voice over asset update job.

To view the progress of Asset Fixer jobs from iTX Desktop:
1 In iTX Desktop, select the Job Monitoring layout.
2 Set the filter at the top of the layout to one of the following:

• Type | Is | Set Audio Logical Audio Data
• Type | is | Set Video Logical Audio Data
• Type | is | Set Live Logical Audio Data

Note: To open the Job Service Manager Configuration dialog after 
installation: 
• Go to Start> All Programs>iTX 2.0>Job Service Manager Config.

The Select Job Service Configuration dialog appears.
• Select SetLogicalAudio.
• Click OK.

Note: To update both video and voice over assets in parallel, you can run 
the update jobs on two separate Opus servers at the same time. One 
instance of the Asset Fixer Service will update the video assets, while the 
other will update the voice over assets.
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3 (Optional) Click  to add an additional filter. This allows you to include both the Set 
Video Logical Audio Data and the Set Audio Logical Audio Data filters.

4 Press the Enter key or click  to begin the search.
5 The Job Monitor layout updates to show only jobs that match the selected type(s).

Checking for updated assets
PinPoint includes a Category filter that allows you to search for assets that have been 
processed by the Asset Fixer Service.

To check for assets that have been updated:
1 In iTX Desktop, select the Asset layout.
2 In PinPoint, select a filter to search for either a video or voice over assets:

• To restrict the search results to video assets, click .
• To restrict the search results to voice over assets, click .
• To restrict the search results to live assets, click .

3 Set the filter at the top of PinPoint to Category | Is | Logical Audio Fixed
4 Press the Enter key or click  to begin the search.
5 The search results displays all of the assets that have been processed by the Asset Fixer 

Service.

Canceling an Asset Fixer job
From within the Job Monitoring layout, you can cancel jobs that are in a State of either 
Active or Waiting.

To cancel an Asset Fixer job:
1 In the Job Monitoring layout, filter the job list to show only the Asset Fixer job you want 

to cancel.
2 Select the job and click Cancel.

The State of the job changes to Cancelled:

Note: The results from this search does not include assets that have had 
their logical audio programs processed by Delivery Manager. These assets 
can be searched using Media filter. See Viewing an Asset’s Logical or Physical 
Audio Mapping on page 89
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Installing and Upgrading Output Server 2 
This chapter discusses how to perform a new installation of Output Server 2 on your 
playout server, including how to configure your iTX domain and create a shared folder to 
use as a media cache. It also explains the differences when upgrading from one version of 
Output Server 2 to the latest version.

If you have a Grass Valley Appliance Server 2 playout server, it will be pre-installed with an earlier 
version of Output Server 2, which will need to be upgraded to the current version. See 
Upgrading an Existing Output Server 2 System on page 22.

If you intend to use IP playout, you will also need to install the IP Routing Service on the 
Framework server and configure its sources and destinations. See the iTX System 
Administration Guide for more information.

Summary
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Installing Output Server 2
Output Server 2 and its related services need to be installed on a playout server, equipped 
with a compatible video/audio I/O card. Of these services, the Media Cache 2 and TXPlay 2 
services require user input before the installation is complete.

For more information on which video/audio I/O cards are supported and the services that 
make up an Output Server 2 system, see About Output Server 2, on page 1.

To perform a new installation of Output Server 2:
1 Access and open the iTX Installer.
2 Right-click the Setup.exe file and select Run as administrator. 

The iTX Select Software to Install window appears.
3 Expand the Playout section
4 Check Output Server 2.
5 Click OK. 

The Select Software to Install window closes. 
6 On the iTX Installer window, click CONTINUE.

The selected components installs on your playout server.
7 During the installation, the iTX Domain Configuration dialog appears. Enter the name 

of the required iTX Domain and Locator Service details, as described in Configuring ITX 
Domain and Locator Service Details, below.
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Configuring ITX Domain and Locator Service Details
iTX services and clients (including iTX Desktops) on the same TCP/IP network can interact 
with each other if they are in the same iTX domain. An iTX domain is identified by a domain 
name assigned to machines on which iTX software runs. In general, iTX services and clients 
belong to the same iTX domain if they run on machines that have the same iTX domain 
name.

As part of a new Output Server 2 installation you are required to enter the details of the iTX 
domain to which the playout server and its channels belong, including the IP addresses of 
any Locator Services in the same domain.

To configure the required iTX Domain and Locator Service Details:
1 During the installation of Output Server 2, the iTX Domain Configuration window 

appears.

2 In the ITX Domain field, type in the name of the required iTX domain.
3 If you have a Locator Service operating in the same domain, check Use Locator Service.

A Locators section appears.

4 Click Add.
An Add Locator dialog appears.

5 In the blank field, enter the IP address for your Locator Service.
6 Click OK.
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7 If you have a group of load balanced Locator Services for the domain, you can enter 
additional IP addresses, then reorder them using the Move Up and Move Down 
buttons.
The order of Locator Services in the list determines the order in which iTX selects them 
to handle connection requests. A service that requires connection details contacts the 
Locator Service at the top of the list, if this one is busy, it contacts the next in the list and 
so on.

8 The Advanced Options button opens an additional dialog, containing a range of 
settings that should only be modified by Grass Valley engineers. 

9 Click Save. 
The iTX Domain Configuration dialog closes and the installation continues.

10 Before the installation completes, the Media Cache Configuration dialog appears. 
Enter the cache name and location, as described in Creating and Sharing a Media 
Cache Folder, below.

Creating and Sharing a Media Cache Folder
As part of a new Output Server 2 installation, you are required to create a folder on your 
playout server to use as the caching location for media as it transitions from your media 
store to playout.

To configure the Media Cache for your playout server:
1 During the installation of Output Server 2, the Media Cache Configuration dialog 

appears.

2 By default, the Cache Name field will be populated with the playout server’s Windows 
Computer Name followed by the suffix -CACHE. 
You may enter a name of your choice, but you must ensure the name does not match 
any channel names in your iTX system. The name must also include the -CACHE suffix.

3 Click Create CACHE Share. The Create Share dialog appears.

4 Click the Browse button. The Browse For Folder dialog appears.
5 Select a location to create the caching folder (e.g. Computer > C:).
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6 Click Make New Folder and enter the name Cache. 
7 Click OK. 

The Browse For Folder dialog closes and you are returned to the Create Share dialog.
8 Click Share This Folder as ‘CACHE’.
9 Click the Close button. The Create Share dialog disappears, retaining your selection 

and you are returned to the Media Cache Configuration dialog. 
10 Click SAVE to confirm your media cache configuration.

The installation continues.
11 After creating a media cache folder, the iTX Channel Config dialog for TXPlay2 appears. 

At this point you should add any channels that you require on this playout server. See 
Adding Channels to an ITX Playout Server on page 25.

12 Apply any additional configuration that is required for your channel. 
This is covered in the following chapters:

• About Channel Communication and Routing, on page 35.
• Configuring Channel Playout, on page 45.
• Configuring Audio Output, on page 53.
• Configuring Splice Insert Processing, on page 69.
• Configuring Optional Plugins and Functionality, on page 75.

Upgrading an Existing Output Server 2 System
Each release of Output Server 2 introduces new functionality, which means during certain 
updates you may be required to confirm parts of your current installation.

Upgrading from v2.5 Output Server 2 to v2.6 or later
Since the first release of Output Server 2 in iTX v2.5, additional playout types and the I/O 
Device Controller have been introduced. As such, during an upgrade from iTX v2.5 you are 
asked to confirm your basic channel configuration and required playout type.

To upgrade from v2.5 Output Server 2 to v2.6 or later:
1 Download and extract the required version of the iTX Suite.
2 Access and open the iTX Installer.
3 Right-click the Setup.exe file and select Run as administrator.

The iTX Installer appears listing all of the new modules and those that will be updated.
4 Click CONTINUE. 

The updated software will install.
5 During the upgrade you may be asked to confirm your media cache configuration. 

• For information on configuring the media cache, see Creating and Sharing a Media 
Cache Folder, on page 21.

• If no changes to the media cache configuration are required, click Save.
6 Before the upgrade completes, the iTX Channel Config dialog for TXPlay 2 appears. 

To confirm your channel details:
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a Select your required Playout Type. 
For main or backup channels running on their own playout server, the Playout 
Type can be set to a single channel type. If another playout type is required, select 
it from the drop down list.

b In the Root Name field, re-enter the base channel name. 
c Confirm the following fields are correct, as required:

• Channel Name
• Backup (This must be checked for backup channel upgrades)
• Simulcast (if present)
• Plugin
• Edit channel (if present)
• Live channel (if present)
• Integrated XG
• Use Dedicate Softel Driver (only required for external Softel subtitlers)

7 Click SAVE. 
The iTX Channel Config window closes. 

8 Complete the installation of any other iTX modules you have selected, as described in 
the iTX System Administrator Guide.

9 Apply any additional configuration that is required for your playout server. 
This is covered in the following chapters:

• About Channel Communication and Routing, on page 35.
• Configuring Channel Playout, on page 45.
• Configuring Audio Output, on page 53.
• Configuring Splice Insert Processing, on page 69.
• Configuring Optional Plugins and Functionality, on page 75.

Upgrading from v2.6 Output Server 2 to v2.7 or later
Upgrading from iTX v2.6 to the latest release of Output Server 2 follows the standard iTX 
upgrade procedure.

To upgrade from iTX v2.6 to the latest release of Output Server 2:
1 Download and extract the required version of the iTX Suite.
2 Access and open the iTX Installer.
3 Right-click the Setup.exe file and select Run as administrator.

The iTX Installer appears listing all of the new modules and those that will be updated.
4 Click CONTINUE. 

The updated software will install.
5 When the upgrade has completed, click FINISH.

Note: The combination of these fields that is available is determined by the 
selected playout type.
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The iTX Installer closes.
6 Apply any additional configuration that is required for your playout server. 

This is covered in the following chapters:
• About Channel Communication and Routing, on page 35.
• Configuring Channel Playout, on page 45.
• Configuring Audio Output, on page 53.
• Configuring Splice Insert Processing, on page 69.
• Configuring Optional Plugins and Functionality, on page 75.
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Adding Channels to an ITX Playout Server
This chapter explains how to add each type of channel to an iTX system, via the iTX Channel 
Config dialog for TXPlay 2, and the basic rules for ensuring your combination of channels 
and playout servers provide a solid resilience model.

For detailed information on setting up an iTX system, refer to the iTX System Administration 
Guide.
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Channel Resiliency Guidelines
When adding channels to an iTX system consider the following guidelines:

• Backup channels should be kept on separate playout servers from their main channels. 
• If your playout servers have Corvid 44 or 88 video/audio I/O cards or a dedicated 

streaming network adapter, a dual channel playout type can be used transmit the main 
for one channel and backup for a different channel. For example:

• Playout Server 1 runs channel A main and channel B backup.
• Playout Server 2 runs channel B main and channel A backup.

• A simulcast channel does not provide redundancy for a main channel. If a main channel 
fails, its simulcast follower also fails. Therefore, it is acceptable to run a main channel 
and its simulcast channel on the same playout server. 
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About the iTX Channel Config Dialog
The basic details for the channel (or channels) you want to run on a playout server are 
created using TXPlay 2’s iTX Channel Config dialog. From here you can define the channel 
name, playout type, channel type and whether or not to use Vertigo XG graphics or the 
legacy Softel subtitle drivers for external Softel subtitlers. 

This dialog appears during the installation of Output Server 2 and can also be accessed 
independently using the TXPlay 2 Config shortcut on your playout server’s Windows 
desktop.
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The table below describes the features of the iTX Channel Config dialog:

Field Description

SDI Device Read only field that displays the name of your current SDI video/audio I/O 
card.

Playout Type This drop-down list contains the available playout types for the 
video/audio I/O card currently installed in the playout server. 
The available playout types are:
• Dual channel
• Dual live
• Simulcast
• Single channel
• Single channel (4K) — SDI only
• On-Demand
For each playout type there is a version for combined SDI and IP targets 
and a version for IP only targets. The playout type you select here 
determines what other fields and options are displayed.

Channel Name This field has two functions:
When creating channels, use this field to enter a name to identify the 
channel. When entering names the following rules must be followed:
• Each channel name must be unique.
• You cannot enter hyphens or minus symbols (-).
• Backup and Simulcast channels must have the same name as their main channel.
If one or more channels have already been created, this field becomes a 
drop-down list containing the names of the existing channels. These 
names include any suffixes that are applied when Backup or Simulcast 
are checked.

Note:
An alias for the Channel Name can be created in iTX Desktop to provide a 
user friendly channel name within the Channel Control layouts. For more 
information see the iTX System Administration Guide.

Backup Checking this option identifies the channel as a backup channel and adds 
the suffix -BACKUP (in gray) to the name in the Channel Name drop-
down list.

Simulcast Checking this option identifies the channel as a simulcast channel and 
adds the suffix -SIM (in gray) to the name in the Channel Name drop-
down list. This option is only available if a simulcast playout type is 
selected.

Output 1
Output 2

Sets the Output Target for each channel.
• Output 1 can be set to SDI or IP.
• Output 2 can only be set to IP or None.
See About Output Targets (SDI and IP), on page 2 for more information.

Additional 
Channels
• Edit channel

Check this option to create an edit channel alongside the current channel. 
Edit channels can be used for off air schedule management.

Additional 
Channels
• Live channel

Check this option if you need to play out ad hoc schedule events using the 
Live Control on iTX Desktop
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Creating an Initial Channel During Installation
During a new installation of Playout Server 2, TXPlay 2’s iTX Channel Config dialog appears 
so that you can create your first channel. Whether this is a main, backup or simulcast 
channel depends on how you wish to configure your iTX system.

To create an initial channel during installation:
1 Before the installation of Output Server 2 completes, the ITX Channel Config dialog for 

TXPlay 2 Config appears.
2 On the Playout Type drop-down list, select the required playout type. 

For the main channel in any iTX system, the default single channel Playout Type can be 
used. If another playout type is required, select it from the drop down list.

3 In the Channel Name field, enter the a name to identify the channel. 
4 In the Output 1 drop down list, select one of the following output targets:

• SDI
• IP 2022-2

5 In the Output 2 drop down list, select one of the following targets:
• None
• IP 2022-2

6 Check the following fields, as required:
• Backup
• Simulcast (if present)
• Edit channel (if present)
• Live channel (if present)
• Integrated XG

Integrated XG Check this option if the playout server features integrated Grass Valley 
Vertigo XG graphics solution (often called XG Inside).
For more information about configuring XG Inside, see the Vertigo XG 
Inside User Manual.

Use Dedicated 
Softel Driver

By default, Output Server 2 uses a legacy driver for external Softel 
subtitles. Check this option to enable the updated driver, which supports 
Softel Swift TX Classic, Softel Swift mTX and Softel Swift mTX Multi-
Language external subtitlers.

Add Extra Channel If you have selected a playout type that supports multiple channels on a 
single playout server (such as dual channel or simulcast), click Add Extra 
Channel to create the additional channels.

Remove Channel Remove the currently selected channel. 

Save Any changes you make to a channel are only applied when you click Save. 
This includes channel deletions.

Field Description
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• Use Dedicate Softel Driver (only required for external Softel subtitlers)

7 Click SAVE. 
The iTX Channel Config window closes. 

8 Configure Output Server 2 for your channel. This is covered in the following chapters:
• About Channel Communication and Routing, on page 35.
• Configuring Channel Playout, on page 45.
• Configuring Audio Output, on page 53.
• Configuring Splice Insert Processing, on page 69.
• Configuring Optional Plugins and Functionality, on page 75.

Adding a Backup Channel to an iTX System
If you are creating a main/backup setup, you need to add the backup channel on a separate 
playout server from the main channel. This ensures the backup channel is unaffected in the 
event of the main channel failing.

To add a backup channel on its own playout server:
1 If is it not currently running, start TXPlay 2 Config by double-clicking on the TXPlay 2 

Config icon on the Windows desktop. 
The iTX Channel Config dialog appears.

2 The Playout Type drop-down list will default to a single channel type. For a backup 
channel in a typical main/backup setup a single channel type is recommended.

3 In the Channel Name field, enter the same channel name as the main channel.
4 In the Output 1 drop down list, select one of the following output targets:

• SDI
• IP 2022-2

5 In the Output 2 drop down list, select one of the following targets:
• None
• IP 2022-2

6 Check Backup. 
The Channel Name field now displays the name you entered followed by -BACKUP, e.g. 
ITX1-BACKUP.

7 Check the following fields, as required:
• Edit channel
• Live channel
• Integrated XG
• Use Dedicate Softel Driver (only required for external Softel subtitlers)

8 Click SAVE. The iTX Channel Config window closes. 

Note: The fields that are available are determined by the selected Playout 
Type.
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9 If you are adding a backup channel as part of an installation, complete the installation 
as normal.

10 The configuration of a backup mirrors that of their main channel. Within the Output 
Server user interface, any configuration changes on the main channel are automatically 
applied to the backup and vice versa.
This is covered in the following chapters:

• About Channel Communication and Routing, on page 35.
• Configuring Channel Playout, on page 45.
• Configuring Audio Output, on page 53.
• Configuring Splice Insert Processing, on page 69.
• Configuring Optional Plugins and Functionality, on page 75.

Adding a Simulcast Channel to an iTX System
A simulcast channel can be created for any existing channel, providing the playout server 
has a compatible video/audio I/O card installed. For more information see Playout Type 
Support, on page 5.

To add a simulcast channel to its own playout server:
1 If is it not currently running, start TXPlay 2 Config by double-clicking on the TXPlay 2 

Config icon on the Windows Desktop. 
The ITX Channel Config dialog appears.

2 On the Playout Type, select one of the following types:
• Corvid 44, Simulcast (allows both SDI and IP targets to be configured)
• Corvid 88, Simulcast (allows both SDI and IP targets to be configured)
• IP Only, Simulcast 

3 In the Channel Name field, enter the same channel name as the main channel.
4 In the Output 1 drop down list, select one of the following output targets:

• SDI
• IP 2022-2

5 In the Output 2 drop down list, select one of the following targets:
• None
• IP 2022-2

6 Check Simulcast. 
The Channel Name field now displays the name you entered followed by -SIM, e.g. 
ITX1-SIM.

7 Check the following fields, as required:
• Integrated XG
• Use Dedicate Softel Driver (only required for external Softel subtitlers)

Note: The steps below describe the process for creating a simulcast 
channel on its own playout server. To add a simulcast channel to a 
playout server that already has a channel configured on it, see Adding 
Extra Channels to a Playout Server, on page 32.
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8 Click SAVE. 
The iTX Channel Config window closes.

9 If you are adding a simulcast channel as part of an installation, complete the 
installation as normal.

10 The configuration of a simulcast channel should match their main channel, with the 
following differences:

• Set the main channel to a HD resolution (e.g. 1080i) and the simulcast channel to 
an SD resolution (e.g. 625).
See Selecting the Channel Resolution and Frame Rate on page 46.

• Configure the aspect ratio to the requirements of the main and simulcast channels 
independently. For example, being HD, the main channel may need an aspect ratio 
of 16:9, while the simulcast channel, which is SD, may only need an aspect ratio of 
4:3.
For more information see the iTX System Administration Guide.

• On the simulcast channel, define event substitution rules to swap HD logos, stills 
and CGs for their SD counterparts.
See About Event Substitution Rules for Simulcast Channels on page 41.

• Configure the audio output to the requirements of the main and simulcast 
channels independently. For example, the main channel may use Dolby E 5.1, while 
the SD channel may only use PCM 5.1.
See Configuring Audio Output on page 53.

Adding a Simulcast Backup Channel to an iTX System
If you have a backup channel for your main channel, as well as a simulcast channel, it is 
recommended that you also add channel that is a backup of the simulcast channel. 

To add a simulcast backup channel to its own playout server:
1 If is it not currently running, start TXPlay 2 Config by double-clicking on the TXPlay 2 

Config icon on the Windows Desktop. 
The ITX Channel Config dialog appears.

2 On the Playout Type, select one of the following types:
• Corvid 44, Simulcast (allows both SDI and IP targets to be configured)
• Corvid 88, Simulcast (allows both SDI and IP targets to be configured)
• IP Only, Simulcast

3 In the Channel Name field, enter the same channel name as the main channel.
4 In the Output 1 drop down list, select one of the following output targets:

• SDI
• IP 2022-2

Note: The steps below describe the process for creating a simulcast 
backup channel on its own playout server. To add a simulcast backup 
channel to a playout server that already has a channel configured on it, 
see Adding Extra Channels to a Playout Server, on page 32.
31



Adding Channels to an ITX Playout Server
Adding Extra Channels to a Playout Server
5 In the Output 2 drop down list, select one of the following targets:
• None
• IP 2022-2

6 Check Backup. 
The Channel Name field now displays the name you entered followed by -BACKUP, e.g. 
ITX1-BACKUP.

7 Check Simulcast. 
The Channel Name field now displays the name you entered followed by -BACKUP-
SIM, e.g. ITX1-BACKUP-SIM.

8 Check the following fields, as required:
• Integrated XG
• Use Dedicate Softel Driver (only required for external Softel subtitlers)

9 Click SAVE. The iTX Channel Config window closes. 
10 If you are adding a simulcast backup channel as part of an installation, complete the 

installation as normal.
11 Simulcast backup channels should be configured in exactly the same way as the 

simulcast channel. 
For more information see Configuring the Channel Communication Setup, on page 40.

Adding Extra Channels to a Playout Server
If are going to operate multiple channels from a single playout server (i.e. a simulcast 
channel on the same playout server as the main channel), the extra channel can be added 
to your iTX system from the iTX Channel Config dialog in TXPlay 2 Config. 

To add an extra channel to a single playout server:
1 If is it not currently running, start TXPlay 2 Config by double-clicking on the TXPlay 2 

Config icon on the Windows Desktop. 
The ITX Channel Config dialog appears.

2 From the Playout Type drop-down list, select one of the following types:
• Simulcast 
• Dual Channel

The Add Extra Channel button appears at the bottom of the dialog.
3 In the Output 1 drop down list, select one of the following output targets:

• SDI
• IP 2022-2

4 In the Output 2 drop down list, select one of the following targets:
• None
• IP 2022-2

5 Click Add Extra Channel. 
The Add Extra Channel dialog appears.
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6 In the Channel Name field, type the basic name for the extra channel, as per the rules 
defined in About the iTX Channel Config Dialog, on page 26.

7 Define the channel’s function:
a If you are creating a backup channel, check Backup.
b If you are creating a simulcast channel, check Simulcast.
c If you are creating a simulcast backup channel, check both Backup and Simulcast.

8 Click OK. 
The Add Extra Channel dialog closes.

9 On the iTX Channel Config dialog, the Channel Name field is now a drop down list, 
which includes the new channel name with the appropriate suffixes in gray (e.g. -
BACKUP for a backup channel, -SIM for a Simulcast channel or both).
You can select each channel from the Channel Name drop-down list and configure 
them individually, as required.

10 Click SAVE. 
The iTX Channel Config window closes. 

11 If you are adding a channel as part of an installation, complete the installation as 
normal.

12 Apply any configuration that is required for your playout server. 
This is covered in the following chapters:

• About Channel Communication and Routing, on page 35.
• Configuring Channel Playout, on page 45.
• Configuring Audio Output, on page 53.
• Configuring Splice Insert Processing, on page 69.
• Configuring Optional Plugins and Functionality, on page 75.

Creating a Dual Channel iTX System
iTX allows for two different channels to operate on a single playout server (for example 
channel A main and channel B backup), providing it is installed with a compatible 
audio/video I/O card. For more information see Playout Type Support, on page 5. 

To create a dual channel system on a single playout server:
1 If is it not currently running, start TXPlay 2 Config by double-clicking on the TXPlay 2 

Config icon on the Windows Desktop. 
The ITX Channel Config dialog appears.

2 From the Playout Type drop-down list, select Dual Channel.
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3 Add the first channel, as described in Creating an Initial Channel During Installation, on 
page 28.

4 Click Add Extra Channel. The Add Extra Channel dialog appears.
5 Fill-in the Add Extra Channel dialog, as described in Adding Extra Channels to a 

Playout Server, on page 32.
6 Apply any playout configuration that is required for your playout server. 

This is covered in the following chapters:
• About Channel Communication and Routing, on page 35.
• Configuring Channel Playout, on page 45.
• Configuring Audio Output, on page 53.
• Configuring Splice Insert Processing, on page 69.
• Configuring Optional Plugins and Functionality, on page 75.

Creating a Dual Live Channel
A dual live channel has two live inputs into a single playout server, which are then played 
out via a single output. For this, the playout server must be installed with a compatible 
audio/video I/O card. For more information see Playout Type Support, on page 5. 

To create a dual live channel:
1 If is it not currently running, start TXPlay 2 Config by double-clicking on the TXPlay 2 

Config icon on the Windows Desktop. 
The ITX Channel Config dialog appears.

2 From the Playout Type drop-down list, select Dual Live.
3 Create the channel, as described in Creating an Initial Channel During Installation, on 

page 28.
4 Apply any playout configuration that is required for your playout server. 

This is covered in the following chapters:
• About Channel Communication and Routing, on page 35.
• Configuring Channel Playout, on page 45.
• Configuring Audio Output, on page 53.
• Configuring Splice Insert Processing, on page 69.
• Configuring Optional Plugins and Functionality, on page 75.

5 Configure the routing so the channel has two live inputs. See About Video Signal 
Routing on page 35.

6 From the Asset layout in iTX Desktop, create a live asset. This can then be scheduled for 
playout on the channel. For more information see the iTX Desktop Operator guide.
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About Channel Communication and 
Routing
This section explains how to setup the routing for a playout server using an existing 
video/audio matrix router. It does not explain how to install or configure a matrix router or 
the supporting iTX services.

For more information on installing and configuring matrix routers, refer to the “Using iTX 
with a Matrix Router” section of the iTX System Administrator Guide.

The guidance in this section is for an iTX playout server with live inputs, however some 
information is also applicable to an iTX server running the Encode service for ingest or both 
the Encode service and Output Server 2 service for ingest and playout.

For more information on setting up an ingest server, refer to the “Preparing Encode Server 
machines” section of the iTX System Administrator Guide.

Summary
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About Video Signal Routing
A video/audio router (also known as a matrix router or just matrix) allows a video signal 
source (such as a live satellite feed) to be connected to a destination, such as a playout 
server. The output from the sources are connected to inputs on the router and the outputs 
on the router are connected to inputs on the destinations. The router then allows any 
source to be routed to any destination and vice versa; these connections are known as 
crosspoints. An iTX server can act as a source (playout server), a destination (ingest server) 
or both (playout with live inputs), depending on your requirements.

For example, the live feed from a satellite would be a source and a transmission system 
would be a destination. In between you may want an iTX server (for example, so that the 
satellite feed can be recorded or breaks inserted), before being sent to the transmission 
system. In this scenario, the live satellite feed is routed to the inputs of a playout/ingest 
server (acting as a destination) via the matrix router and the output from the playout/ingest 
server (acting as a source) can then be routed to the transmission system via the same 
router.

Note: Some of the following configuration only applies to SDI output 
targets and some only applies to IP output targets. Where configuration 
is specific to an output target it is stipulated in the heading.
 35



About Channel Communication and Routing
Assigning SDI Matrix Destinations to Channel Inputs
Figure 5-1 on page 36 illustrates how source and destinations can be routed to one another, 
via crosspoints on the matrix router. The diagram also shows how the example above 
would be routed, with the live satellite feed being used as an input source to the 
playout/ingest server (ITX1),which is then routed to the transmission system.

Fig. 5-1: How channel sources and destinations connect to a matrix router.

There can be multiple sources, destinations and even routers in an iTX system. To ensure a 
playout/ingest server is receiving and sending the correct signals, iTX needs to know the 
following:

• Which router to use
• The destinations (i.e. to which router outputs are the inputs on the video/audio I/O card 

connected)
• The channel outputs (i.e. to which router inputs are the outputs on the video/audio I/O 

card connected)

How a channel's routing is configured also depends on the playout type. For example, 
simulcast channels share an input, so the playout server acts as a single destination; dual 
live input requires two inputs, so the playout server acts as two destinations (i.e. two 
different outputs on the router connect to two different inputs on the video/audio I/O 
card).

The playout server’s inputs are configured from within the Router Connections tab in the 
I/O Device Controller, while the channel outputs are configured in the Channel Config pop-
up layout in iTX Desktop. 

Assigning SDI Matrix Destinations to Channel Inputs
In the I/O Device Controller user interface, under Configuration > SDI is a Routing section, 
which is used to assign each channel input to a destination on a matrix router. 
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The inputs that are available correspond to the model of video/audio I/O card in your 
playout server and the playout type you selected in TXPlay2 Config. For example, a Corvid 
44 video/audio I/O card shows the following inputs for each playout type:

To assign matrix destinations to inputs on the SDI I/O card:
1 On the server running the Output Server 2 system, maximize the I/O Device Controller 

service.
2 Select the Configuration > SDI tab.

The routing configuration appears, with a set of controls for each active input on the 
video/audio I/O card.

3 For each input, use the Matrix field to select the matrix router (or router bridge) with 
the required destination.

4 For each input, use the Destination field to select the router destination to which the 
transmission system receiving the channel output is connected.

The table below describes how different channel types and pairings should be routed.

Playout type Inputs Router configuration

Single channel • Channel A Main Input Single router, with a single destination

Single channel 
(4K)

• Channel A Main Input 1
• Channel A Main Input 2
• Channel A Main Input 3
• Channel A Main Input 4

Single router, with four destinations.
Note: 4K input is only supported by AJA Corvid 88 
SDI audio/video I/O cards.

Dual channel • Channel A Main Input
• Channel B Main Input

Up to two routers, with two separate destinations

Dual live • Channel A Main Input
• Channel A Secondary Input

Up to two routers, with two separate destinations

Simulcast • Channel A Main Input / 
Channel B Main Input

Single router, with a single destination

Note: If you are using a hardwired router for testing purposes, you can only 
connect one destination to it and you cannot mix router systems.

Channel types Matrix destination

Main and backup pair Connect both channels to the same matrix and 
destination

Simulcast and simulcast backup pair Connect both channels to the same matrix and 
destination

Main and simulcast pair Connect both channels to the same matrix and 
destination

Backup and simulcast backup pair Connect both channels to the same matrix and 
destination

Dual channel pair Connect channel A main input and channel B main 
input to separate matrix destinations

Dual live channels Connect channel A main input and channel A 
secondary input to separate matrix destinations
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Assigning IP Routing Matrix Destinations to Channel Inputs
5 Click Save.
6 Now configure the output for each channel from the iTX Desktop. See Assigning Matrix 

Sources to Channel Outputs on page 39.

Assigning IP Routing Matrix Destinations to Channel Inputs
Using the I/O Device Controller on the playout server, you must assign one or more 
destinations from the IP Router Matrix to each input channel.

The IP Routing tab on the I/O Device Controller provides a collapsible section for each of 
the device’s input channels as determined by the Playout Type you selected in the TxPlay 2 
Config. 

The connection name and IP address of the available network adapter’s connections is 
automatically detected and displayed.

To assign an IP Routing Matrix destination to the channel input on the playout server:
1 On the server running the Output Server 2 system, maximize the I/O Device Controller 

service.
2 Select the Configuration > IP tab.
3 In the input channel’s panel (e.g. Channel A, Channel B or Channel A/B), click the 

Show/Hide button  to display the channel’s current IP Input assignments.
4 Click the Add new IP Input button and a new IP-INPUT-# line is added.
5 From the Matrix drop-down list, select IP Matrix.
6 Click the Destination button.
7 From the Select Destination window, select the destination from the IP Router Matrix 

that you would like to be delivered to the channel’s input.

Dual live simulcast Connect channel A/B main input and channel A/B 
secondary input to separate matrix destinations. 
TXPlay 2 controls which input to use at any given 
time.

Backups of dual channels or dual live 
channels.

Connect each backup to the same matrix and 
destination as their main channel (e.g. channel A 
backup should be routed to the same matrix 
destination as channel A).

Channel types Matrix destination

Playout Type Inputs

Single Channel 
(including 4K)

• Channel A

Dual Channel • Channel A 
• Channel B 

Simulcast • Channel A/B

Dual Live • Channel A 
• Channel A
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8 Click OK and the destination name is added to the channel’s IP-Input’s Destination text 
box.

9 Optional: Repeat step 4 to step 8 to add addition inputs to the streaming network 
adapter. 

10 Click Save.

Assigning Matrix Sources to Channel Outputs
As well as configuring the matrix router destinations from I/O Device Controller, you must 
assign the matrix router sources to channel outputs. This is performed in iTX Desktop, from 
the Channel Config pop-up on the Engineering layout.

To assign matrix sources to channel outputs:
1 Start the iTX Desktop on a client PC and login with an Administrator profile.
2 Open the Engineering layout.
3 Click Channel Config. 

The Channel Config pop-up layout appears.
4 From the View list, select the view with the channels to be configured.
5 Select a channel to configure.
6 Click the Channel Config 3 tab, which contains the Routing panel. 

7 From the Matrix field, select the matrix router (or router bridge) with the required 
source inputs.
This must be the router to which the transmission system receiving the channel output 
is connected and is typically the same matrix that is configured in the Router 
Configuration panel of the I/O Device Controller.

8 From the Channel Output field, select the router source input the channel output is fed 
into.

9 From the Channel Output 2 field, select any router source input you want to monitor.
This option is useful for monitoring a live video signal for a pass-through channel that is 
being fed into a separate playout/ingest server.

10 Click Save and then Close.

Selecting the Default Live Asset for the Channel
Where a fixed router source is used for a number of different live assets that are unknown to iTX, 
a default live asset can be substituted in each case without changing the unique names of the 
original live assets. This is performed in iTX Desktop, from the Channel Config pop-up on the 
Engineering layout. 

To select the default live asset for the channel:
1 Start the iTX Desktop on a client PC and login with an Administrator profile.
2 Open the Engineering layout.
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3 Click Channel Config. 
The Channel Config pop-up layout appears.

4 From the View list, select the view with the channels to be configured.
5 Select a channel to configure.
6 Click the Channel Config 3 tab, which contains the Routing panel.
7 From the Default Live Asset field, select the name of the default live asset.
8 Click Save and then Close.

Configuring the Channel Communication Setup
In iTX Desktop you need to define the channel communication setup. This is critical for 
TXPlay 2 to be able to manage the leader/follower network for any channels that are in a 
main/backup or simulcast setup.

As well as stating which channels are in a main/backup or simulcast setup, the way in which 
the channels are routed is also critical to the configuration. This then allows a channel to be 
failed over using a downstream device equipped with a Grass Valley HCO change-over card. 
The way in which a pair of channels are configured depends on the channel types (i.e. the 
configuration for a simulcast channel is different to that for a dual live channel).

The communication setup is performed using the following options on the Channel Config 
pop-up, on the Engineering panel:

• Matrix selection field on the Routing panel
• Channel Destination selection field on the Routing panel
• Channel Output selection field on the Routing panel
• Master/Slave Setup button
• Simulcast Setup button

To configure the channel communication setup for a channel:
1 Start the iTX Desktop on a client PC and login with an Administrator profile.
2 Open the Engineering layout.
3 Click Channel Config. 

The Channel Config pop-up layout appears.
4 From the View list, select the view with the channels to be configured.
5 Select a channel to configure.
6 Click the Channel Config 3 tab.
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7 From the Matrix field, select the matrix router (or router bridge) with the required 
sources and destinations.
This must be the router to which the transmission system receiving the channel output 
is connected and is typically the same matrix as was configured in the Router 
Configuration panel of the I/O Device Controller.

8 From the Channel Destination field, select an output on the matrix router that delivers 
the output of the main channel. This typically matches the destination that was 
configured in I/O Device Controller. 
The table below describes how different channel types and pairings should be routed.

9 For a main/backup setup, use the Channel Output to select the router input the 
channel output is fed into.

10 Enable the channel communication options using the following criteria:
• For any backup channel or channel with a backup, enable Master/Slave Setup.
• For any simulcast channel or main channel with a simulcast channel, enable 

Simulcast Setup.
• For any channel that is part of both a main/backup setup and a simulcast setup, 

enable both options.
11 Click Save and then Close.

About Event Substitution Rules for Simulcast Channels
When using a simulcast channel, you can define a rule to determine when logo, CG and 
stills events scheduled on the main channel are substituted on the simulcast channel. For 
example, so that 4K or HD branded logos can used on higher resolution channels, without 
them appearing on the lower resolution simulcast channel. Only one rule can be defined 
for each simulcast pair and it is applied to all matching assets. 

Substitutions are defined on the Simulcast Channel Config panel by the suffix of the higher 
resolution asset name, the suffix of the lower resolution asset name or both. For example, if 
_HD is entered into the Original Suffix field and _SD is entered into the Substitution field, 

Channel types Channel destination

Main and backup pair Route both channels to the same matrix and destination

Simulcast and simulcast 
backup pair

Route both channels to the same matrix and destination

Main and simulcast pair Route both channels to the same matrix and destination

Backup and simulcast backup 
pair

Route both channels to the same matrix and destination

Dual live channels Route to the matrix and destination specified in I/O 
device Controller.
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an asset called iTX-Logo_HD would be substituted for a file called iTX-Logo_SD before 
playing out on the simulcast channel.

Cascading Logo Replacement Rules
On playout, if a scheduled logo is defined in the Logo Setup plugin it will be substituted for 
its replacement before going to air. 

If you are running a Simulcast channel and the replacement logo then meets the criteria 
defined in the Simulcast Replacement Rules, a further replacement will be performed. 

This provides two levels of control for logo replacement, as illustrated by Figure 5-2.

Fig. 5-2: How logo replacement rules cascade in iTX Desktop

Note:
• If Logo or CG are selected for substitution, live logos and live captions are 

also be subject to the same replacement rules.
• Both the original and the substitution assets must be available on the 

media store for the substitutions to take place.
• If you are operating a simulcast backup channel, you must apply the same 

substitution rules on the simulcast backup channel as its simulcast 
channel it is paired with.
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For more information about logo replacement using the Logo Setup configuration, see the 
iTX System Administration Guide.

Defining an Event Substitution Rule for a Simulcast Channel

To define an event substitution rule:
1 Open the iTX Desktop and click the Engineering layout.
2 Click Channel Config. 

The Channel Config pop-up layout appears.
3 From the View list, select the view containing the channels to be configured. The 

channels associated with that view appear.
4 Click the name of the channel to be configured.
5 Click the Simulcast Channel Config tab.
6 In the Original Suffix field, enter the characters used to identify the higher resolution 

events. For example, for a HD/SD pair, enter _HD, while for a 4K/HD pair, enter _4K.
7 In the Substitution field, enter the characters used to identify the lower resolution 

events. For example, for a HD/SD pair, enter _SD, while for a 4K/HD pair, enter _HD.
8 As you type in the Original Suffix or Substitution fields, the For Example text updates 

to demonstrate how the rules will be applied. For example:

9 From the Available Plugins list, select which event types you want to substitute, then 
click >> to add them to the Selected Plugins list.

10 Click Save.

About GPI Devices and Simulcast Setups
As simulcast channels follow the main channel and cannot, in a leader/follower network, 
become leader channels, there is no requirement to configure GPI devices for simulcast or 
simulcast backup channels.

IMPORTANT
The required assets must be prepared with the appropriate suffixes prior 
to being scheduled.

Original Suffix 
text

Substitution 
text For example text

(None) (None) AssetName Keep as AssetName

(None) _SD AssetName Append to Make AssetName_SD

_HD (None) AssetName_HD Remove to Make AssetName

_HD _SD AssetName_HD Replace with AssetName_SD 
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Configuring Channel Playout
There are essential configuration steps that must be followed for your channels to playout 
as expected. This includes the selecting the reference source and frame rate family, 
selecting the channel resolution, configuring timecode and Active Format Description 
settings, configuring the output target parameters and adjusting the channel timing and 
delay.
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Setting an SDI Reference Source and Frame Rate Family
If you are using an SDI video/audio I/O card, before configuring Output Server 2 you should 
confirm your I/O Device Controller has the correct reference source and, if required, frame 
rate family. You set the reference source and frame rate family from the Configuration > SDI 
tab of the I/O Device Controller user interface.

To set the reference source and frame rate family:
1 On the playout server running the Output Server 2 system, expand the I/O Device 

Controller. 
The I/O Device Controller user interface appears. 

2 Select the Configuration > SDI tab. 
The SDI configuration panel appears:

Note: Some of the following configuration only applies to SDI output 
targets and some only applies to IP output targets. Where configuration 
is specific to an output target it is stipulated in the heading.

Note: The Reference and Frame Rate Family for the channel must be 
specified from the I/O Device Controller user interface before a Resolution 
can be selected in the Channel tab of the Output Server 2 user interface. 
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If your playout server is equipped with dual Corvid LP video/audio I/O cards, there is a 
separate Reference, Frame Rate and Output Timing Control section for each card:

3 If you are using an external reference input: 
a From the Reference drop-down list, select External.

When the external reference input is connected to your video/audio I/O card, the 
frame rate family is locked to that of the reference. 

b Continue with Configuring IP Output Target Parameters, on page 49.
4 If you do not have an external reference:

a From the Reference drop-down list, select Freerun. 
b From the Frame Rate Family drop-down list, select a frame rate (e.g. 50.00 Hz). 

This determines the resolution you can set in the Channel tab of the Output Server 
2 Configuration user interface. See Selecting the Channel Resolution and Frame 
Rate on page 46 for more information.

5 Click Save to store your changes.

Selecting the Channel Resolution and Frame Rate
The resolution and frame rate for a channel is configured from the Channel tab of the 
Output Server 2 user interface.

Note: If you are not using an external reference input on your video/audio 
I/O card, you must set the Reference to Free Run and an appropriate Frame 
Rate Family for the playout server. Without a reference and frame rate family, 
the Output Server 2 service starts up in an error state. See Viewing the 
Output Server 2 Engineering Panel on page 111.
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To configure the Resolution and Frame Rate for an Output Server 2 channel:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Go to Configuration > Channel tab. 
The channel configuration options appear. The Resolution and Frame Rate controls are 
on the top left of the window.

3 Specify the Resolution (e.g. 1080p 59.95Hz for NTSC full HD or 4K(QFHD) 59.94 for 
NTSC 4K) for the channel using the drop-down list.

4 The Frame Rate is read only and is determined by the Frame Rate Family setting I/O 
Device Controller configuration and cannot be changed from Output Server 2.

5 Click Save to store your changes and automatically reboot the Output Server 2 service.
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Configuring Channel Delay
A channel delay may be needed to adjust the output timing for transitions, such as when 
switching the output of a national channel into and out of regional sub-channels. For 
accurate transitions, the internal processing may need adjusting to take account of the 
throughput time of a live source. 

To configure the channel delay for an Output Server 2 channel:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Go to Configuration > Channel tab. 
3 In the Channel Delay (sec:ms) field, enter a value in seconds and milliseconds or use 

the spinner button.
4 Click Save to store your changes and automatically reboot the Output Server 2 service.

Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Configuring SDI Timecode Settings (VITC, ATC, LTC, DVITC) 
So that media can be identified, synchronized and edited, timecodes are added to the 
ancillary data space of the television signal as media metadata. The way that timecodes are 
encoded and processed is different for SD and HD media and there are several formats, 
both current and legacy, for encoding timecodes. 

iTX supports VITC (Vertical Interval Timecode) times for SD media and ATC (ancillary 
timecode) timecodes for HD media. Both are configured from the Channel tab of the 
Output Server 2 user interface.
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To configure timecode settings for an Output Server 2 channel:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Go to Configuration > Channel tab. 
The channel configuration options appear in the upper portion. 

3 Expand the VANC heading to expose the timecode options.
4 If the channel broadcasts SD content and you are using a VITC (Vertical Interval 

Timecode) generator, select the line numbers to use for VITC timecodes.
a For SD VITC Detection Line, select the line number to indicate the presence of 

timecode information to downstream devices.
b For SD VITC Insertion Line, select the line number on which the timecode 

information is placed.
5 If the channel broadcasts HD content, for HD ATC Source Type, use the drop-down list 

to select the source input for ancillary timecodes. The options are:
• LTC for linear timecode sources.
• DVITC for Digital Vertical Interval Timecode sources.

6 The HD ATC Output Type field defaults to LTC+DVITC. Currently, this is the only 
available setting.

7 Click Save to store your changes and automatically reboot the Output Server 2 service.
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Configuring SDI Active Format Description Insertion Lines
Information about what area of a 16:9 HD video image should be preserved when it is 
downscaled to 4:3 SD is defined by Active Format Description (AFD) codes. These AFD 
codes are carried in the baseband signal coming into the video/audio I/O card and then 
interpreted by viewers’ televisions and set top boxes to display the required frame for each 
item in the schedule. The standards for AFD are defined by the Society of Motion Picture 
and Television Engineers (SMPTE) and Output Server 2 supports SMPTE Standards 2016 and 
RP186 AFD codes. 

You configure the lines on which AFD codes are inserted for each SMPTE standard from the 
Channel tab of the Output Server 2 user interface.

To configure AFD insertion lines for an Output Server 2 channel:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Go to Configuration > Channel tab. 
The channel configuration options appear. 
The channel configuration options appear in the upper portion. 

3 Expand the VANC heading to expose the AFD options.
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4 The values for the AFD insertion lines are determined by the selected Resolution. The 
default is typically the switch line +2 for all formats. 
To change the default values, enter the new values into the following fields:

• AFD S2016 Insertion Line
• AFD RP186 Insertion Line

5 Click Save to store your changes and automatically reboot the Output Server 2 service.
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Configuring Output Branding Levels for SDI and IP Output Targets
Each output target (SDI main, SDI secondary, and IP) can be assigned an output branding 
level to determine the types of secondary events that can be included/excluded from the 
output. For example, one output target may be configured Clean, which will exclude any 
logos or voice overs, while another output may be set to Complete and include all 
branding. 

Note that logos and CGs are rendered on top of any XG Inside branding. 

To set the output target’s branding level:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. iTX1 Output Server 2).
2 Select the Configuration > Channel tab.

The channel configuration options appear.
3 Select the Output 1 or Output 2 sub-tab.
4 From the Main Output Branding Level drop-down list, select a branding level:

• Clean: Includes the primary event, DVEs and PIPs. Excludes logos, CGs or voice-
overs.

• XG: Includes all items in the Clean level, and adds XG rendering.
• Logo: Includes all items in the XG level, and adds iTX logos and CGs .
• Voice Over: Includes all items in the Logo level, and adds voice overs.
• Complete: Includes all secondary events and open subtitles.

5 If the Secondary Output Branding level field appears, set the branding level for the 
secondary SDI output.  
Note that this field only appears if the playout server’s video/audio I/O card supports a 
secondary SDI output (refer to I/O Device Controller’s Engineering tab).

6 Click Save to store your changes and automatically reboot the Output Server 2 service.
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Configuring IP Output Target Parameters
If you selected IP as either of the channel’s Output targets, you must set the IP channel 
parameters which determine the encoding characteristics for IP playout.
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To configure the IP output target parameters:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. iTX1 Output Server 2).
2 Select the Configuration > Channel tab.

The channel configuration options appear.
3 Select the Output 1 (IP-2022-2) or Output 2 (IP-2022-2) sub-tab.
4 If you have not done so already, set the output branding level. See Configuring Output 

Branding Levels for SDI and IP Output Targets, on page 49.
5 From the Preset drop-down list, select an IP output preset.

If the desired preset is not displayed in the Preset drop-down list, click the browse (...) 
button and then Import to locate and import a preset.

6 From the Video Codec drop-down list, select either MPEG2 or AVC.
7 Click the browse (...) button next to the Video Codec drop-down list and set the 

following options for the Video Codec:
• Quality: Select the desired output image quality level. Higher quality requires more 

CPU time.
• Profile and Level: Set the maximum image resolution and encoding bitrate 

possible. Refer to the H.262 and H.264 encoding standards.
• Bitrate (kbits/s): Displays the constant bitrate to allocate to the video portion of 

the transport stream. Variable bitrate mode is not supported. Values are expressed 
in kilobits per second. Note that 1 kilobit = 1000 bits. 

8 In the Video PID field, set a value to define the Packed Identifier of the channel in the 
output IP transport stream. Valid PID numbers range from 32 to 8186 and must be 
unique across a given IP output target.

9 Expand the Destination heading and set the following parameters:
• IP Protocol: Select rtp or udp. 

Note that rtp brings error correction on the IP communication link at the cost of 
some more bandwidth.

• Address: Specify the IP address of the destination for the IP stream (playout server).
• Port: Specify the port number of the playout server.
• Sending Interface: Specify the IP address of the network adapter carrying the IP 

stream.
10 Expand the Destination heading and set the following parameters:

• Combined kbps: Specify the total constant bit rate bandwidth in kilobits per 
second allocated for the transport of audio, video and control structures of the IP 
Transport Stream. Set this value to your desired bandwidth.
Note that 1 kilobit is defined as 1000 bits. The default value is 10000 kbps (or 10 
megabits per second) and the maximum value is 50000 kbps.

• PAT Rate (per sec): Specify how many Program Association Tables per second to 
transmit.

• PMT Rate (per sec): Specify how many Program Map Tables per second to transmit.
• PMT PID: Specify the Packed Identifier to associate with the PMT. Valid PID 

numbers range from 32 to 8186 and must be unique across a given IP output 
target.
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• PCR Spacing (ms): Specify the interval in milliseconds between transmissions of a 
Program Clock Reference. 

• PCR on Every PES Packet: Check this option to transmit a PCR on every elementary 
stream packet.

11 Click Save to store your changes and automatically reboot the Output Server 2 service.

Adjusting SDI Output Timing
If you are using an external reference input into your SDI video/audio I/O card, but the 
video input signal and time reference signal are not synchronized, you can compensate by 
adjusting the horizontal and vertical output timing for each output on the video/audio I/O 
card(s). This is done using the controls in the Output Timing Control (Ext. Ref. Only) 
section and monitoring the results on a waveform analyzer. 

To adjust the output timing:
1 On the playout server running the Output Server 2 system, expand the I/O Device 

Controller. The I/O Device Controller user interface appears. 
2 Click the Configuration > SDI tab.

The SDI configuration panel appears, with a set of output timing controls for each I/O 
device in the playout server:

3 Click Selected Output and select the output to be adjusted (either A or B).
4 To set the horizontal output timing value in pixels, enter a value into the box or use the 

slider on the Horizontal (Pixels) field.
5 To set the vertical output timing value in lines, enter a value into the box or use the 

slider on the Vertical (Lines) field.
6 Use a waveform analyzer to ensure the signals are synchronized,
7 Repeat step 3 to step 6 for each output on the playout server.

For example, for a Corvid 44 in simulcast mode, set the timing for outputs A and B. For a 
dual Corvid LP system in dual channel mode, set Corvid 1 output A and Corvid 2 output 
A.

8 Click Save to store your changes.
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Configuring Audio Output 
For audio in video and voice over media, Output Server 2 allows you to configure the 
output channels, Dolby metadata, audio watermarking, upmixing to Dolby 5.1 and 7.1, 
voice over handling and audio substitute rules for individual audio programs, then assign 
those audio programs to audio program output groups as required.

For live assets, this configuration has to be performed within iTX Desktop, from the 
property editor in the Asset layout.

Summary
About Default Audio Program Configurations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  53
Creating an Audio Program  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  54
Selecting the Audio Output Channels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  55
Defining Substitution Rules for Audio Programs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56
Configuring Dolby Metadata  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57
Configuring Audio Upmixing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  58
Configuring Audio Watermarking  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  60
Configuring Voice Overs Playback  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  62
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About Default Audio Program Configurations 
When you access the Audio tab for the first time it includes an initial audio program. How 
this initial audio program is configured depends on whether the instance of Output Server 
2 is for a new channel or an existing channel that has been upgraded to iTX v2.8 or later, as 
well as which audio features you have licensed:

• For a new channel, an audio program called Default is created, with the following 
details:

• The Rule cell contains a P#1 audio label only.
• The Apply VO field is checked.
• The Dolby metadata is configured with basic default settings for stereo output. 
• No upmixing is configured.
• No audio watermark is defined. 
• The Output Channels is set to Stereo

Note:
• When using logical audio programs, the Audio Mapping configuration panel in iTX 

Desktop’s Channel Config 4 layout can be ignored.
• Automatic Loudness Control (ALC) is not supported in iTX v2.8. 
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• For an existing channel:
• The existing audio configuration (output channels, Dolby metadata, watermarking 

and upmixing) is converted into audio programs, with names derived from the 
previous configuration. 

• The Apply VO field* is checked for the first audio program to be assigned to the 
first output group.

Creating an Audio Program
Although Output Server 2 provides default and converted audio programs, you should 
create additional audio programs to support your required combinations of audio 
configuration, outputs, encoding and substitution rules.

For example, you may want to have English audio that plays out with the same substitution 
rules for both stereo and Dolby surround 5.1 outputs. In which case, you should create two 
separate audio programs, then configure them according to these requirements. Each 
audio program can then be assigned to separate audio output program groups or they 
could both be applied to a single Dolby E audio output program group (fulfilling the 5.1+2 
criteria of Dolby E).

To create a blank audio program entry:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 In the Audio Programs section, click on the blank cell in the Name column. 
The word Name appears in the cell.

3 Replace the word Name with a name to identify the audio program (e.g. English5.1 for 
an English audio program in Dolby surround 5.1) and press Enter.
The cell displays the new name and a new blank row appears below.

4 You should now select the output channels for your audio programs. See Selecting the 
Audio Output Channels on page 55.
Alternatively, click Save to store your changes and automatically reboot the Output 
Server 2 service. 

IMPORTANT
The following audio features require separate licenses:
• Dolby metadata
• Audio watermarking (Nielsen)
• Voice overs
If your playout server is not licensed to use one of these features, the 
corresponding user interface will be hidden and the functionality disabled. 
See License Requirements on page 12
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Selecting the Audio Output Channels
Audio programs can be configured to output as mono, stereo, Dolby surround 5.1 or Dolby 
surround Plus 7.1 channels. The audio output channel type you select for an audio program 
affects the following aspects of the audio configuration:

• How Dolby metadata is configured, for example which audio coding modes can be 
selected.

• If you select a surround output channel, you should also configure the upmixing from 
mono and stereo.

• If you have stereo voice overs and surround outputs, you will need to select how they 
are mapped.

• Your selected audio output channels dictates to which audio output program groups 
the audio program can be assigned.

To the output channels for an audio program:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 Click on the Output Channels drop down box for an audio program and select one of 
the following options:

• Mono

• Stereo
• 5.1
• 7.1

3 You should now define the substitution rules for your audio programs. See Defining 
Substitution Rules for Audio Programs on page 56.
Alternatively, click Save to store your changes and automatically reboot the Output 
Server 2 service. 

Note: If you change the default output channel, a pop-up message appears 
asking if you would like to change the Dolby configuration to defaults that 
are appropriate for the output type.
Click Yes to change your Dolby configuration to sensible defaults or No to 
leave the Dolby configuration as is.
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Defining Substitution Rules for Audio Programs
Substitution rules for audio programs are created by assigning audio labels to the audio 
programs in order of preference. i.e. the first label (from the left) is the first one iTX attempts 
to map on playout, then the second label on the left, then the third and so on. 

To define the substitution rule for an audio program:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 In the Audio Programs section, click Available Labels.
The list of labels expands, as shown below:

Note: When defining substitution rules for audio programs consider the 
following points:
• The audio programs labels that appear in the Audio configuration tab of 

Output Server 2 are extracted from media that has been registered in the 
Opus database, either on import or following an update by the Asset Fixer 
job service. Therefore you must prepare your media before configuring 
audio substitution rules. See Preparing for Logical Audio Programs on 
page 15.

• If you are going to create an audio output group with RAW encoding, you 
must create an audio program with unique audio labels that are not 
assigned to any other audio programs.

• Only create as many audio programs as you need to populate the output 
groups you create. You cannot have unassigned audio programs in your 
Output Server 2 configuration.

• If the output from your server is going to a downstream device, you 
may want iTX to play out silence when no matching label can be found 
in the media. This can be done by adding a Silence label to the end of 
your rule. If no Silence label is applied to a rule, when no matching label 
can be found in the media, iTX Desktop will display a warning to the 
operator.
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3 In the Label column, select a label you want to use in the rule.
4 Drag and drop the selected label into the blank cell in the Rule column of an audio 

program. 

5 Repeat step 3 and step 4 to add labels to the Rule cell in the order of preference (from 
left to right). 

6 If silence is required when no matching audio label is found, drag the SILENCE label 
from the bottom of the Available Labels list and add it to the end of your rule.

7 You should now select if you want to apply voice overs to your audio programs. See 
Configuring Dolby Metadata on page 57.
Alternatively, click Save to store your changes and automatically reboot the Output 
Server 2 service. 

Configuring Dolby Metadata
You can configure the Dolby metadata for each audio program you have defined by 
clicking the Edit button in the Dolby column. This displays a Dolby Metadata popup, 
where you can set specific values for each parameter and set a resolution rule. 

To configure Dolby metadata for an audio program:
1 Open the Output Server 2 user interface:

IMPORTANT
The SILENCE label should only be added to the end of the rule (last item on 
the right). If SILENCE is listed before an audio program label, that label will 
never be matched on play out.
In the examples below, the first rule is acceptable, but on the second rule 
audio with the labels P#4 and P#6 would never be matched, because the 
Silence label is before them in the rule.

Note: Dolby metadata configuration is a licensed feature. If your playout 
server does not have the required license the Dolby button will not be 
visible on your Output Server 2 service. See License Requirements on 
page 12.
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a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 In the Audio Programs section, go to the Dolby column for the audio program you 
want to configure and click Edit.
The Dolby metadata pop-up dialog appears.

-

3 Review and/or set the metadata parameters that are listed in the Setting column.
Hovering over the metadata setting field displays a brief description of the metadata 
parameter. 

4 For each metadata parameter, set the associated Rule field to one of the following 
values: 

• Manual Value applies the set value as the constant default. 
• Decoders, then manual value applies a conditional setting such that if the Dolby 

decoder provides a setting for that metadata parameter, then the decoder’s setting 
takes precedent over the set value. 

5 Click OK to store the metadata parameter settings and close the popup.
6 If you have created audio programs with surround channel outputs, you should now 

configure how Output Server 2 is to handle upmixing. See Configuring Audio Upmixing 
on page 58.
Alternatively, you can configure the watermarking for your audio programs. See 
Configuring Audio Watermarking on page 60 or click Save to store your changes and 
automatically reboot the Output Server 2 service. 

Configuring Audio Upmixing
Audio upmixing is only required for channels where the audio input needs to be upmixed 
to Dolby 5.1 or Dolby 7.1; therefore the ability to edit the upmixing properties is only 
available to audio programs that are set to 5.1 or 7.1.

Upmixing can be disabled by enabling the Passthrough (no mixing) setting, which enables 
Dynamic Audio Coding Mode (ACMOD) Switching where the Dolby Metadata configuration 
setting is ignored and default values according to the current ACMOD are used instead.
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To enable and configure audio upmixing:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 In the Audio Programs section, go to the Upmixing column for the audio program you 
want to configure and click Edit.
The Upmixing Configuration pop-up dialog appears for the selected audio program.

3 Leave the Passthrough (no mixing) unchecked (default) to force upmixing. 
If however you want to disable upmixing and allow the audio to pass through as-is, 
check the Passthrough (no mixing) check box and the Upmix configuration options 
are greyed out.

4 In the Stereo (L/R) Channels Level (dB) field, enter the stereo input volume level in 
decibels. 
The minimum value is -24 dB, the maximum is 6 dB and the default is -6 dB. 
Alternatively set the level to Mute.

5 In the Stereo Width field, enter a value from 0 to 31. The default is 27.
6 In the Center (C) Channel Level (dB) field, enter the center input volume level in 

decibels. 

Notes
• Passthrough behavior depends on the selected type of the audio output program 

group to which the audio program is assigned. 
When performing passthrough and the audio output program group is configured 
for PCM 5.1 or 7.1, the passthrough audio will be padded with silence to account 
for any difference in channel count. If the audio output program group type is 
configured for Dolby D or Dolby D Plus, then instead of using the ACMOD 
according to the audio program output channels setting (5.1 or 7.1), it will use an 
ACMOD matching the passed through audio (i.e. 2.0 for stereo).

• The Passthrough setting should not be used in conjunction with an audio output 
program group whose type is Dolby E.
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The minimum value is -24 dB, the maximum is 6 dB and the default is 1 dB. Alternatively 
set the level to Mute.

7 In the LFE Level (dB) field, enter the low-frequency effects input volume level in 
decibels. 
The minimum value is -24 dB, the maximum is 6 dB and the default is -10 dB.
Alternatively set the level to Mute.

8 In the LFE Filter field, enter a value in hertz for low-frequency effects. 
The default is 80Hz for 50Hz video formats and 66.7Hz for 59Hz video formats.

9 Click the Surround Mode field. 
The Select Item dialog appears. 

10 Select the required surround mode. 
The options are:

• Speech (default)
• Standard
• Movie

11 In the Surround (Ls/Rs) Channels Level (dB) field, enter the surround sound input 
volume level in decibels. 
The minimum value is -24 dB, the maximum is 6 dB and the default is -5 dB. 
Alternatively set the level to Mute.

12 In the Surround Delay (ms) field, enter the required delay in milliseconds. The default is 
16.

13 Click OK to store the upmixing settings and close the popup.

14 You should now configure the watermarking for your audio programs. See Configuring 
Audio Watermarking on page 60.
Alternatively, click Save to store your changes and automatically reboot the Output 
Server 2 service. 

Configuring Audio Watermarking
An audio watermark is an inaudible cue tone in the audio stream of the channel output 
signal. In the USA and Canada, the Nielsen audio watermark is detected by devices that 
provide information for television audience measuring.

Both Nielsen watermarking version 2 (N2) and version 4 (NW) are supported. Either format 
can be inserted individually or both can be inserted simultaneously into the data stream. 
Unlike N2 watermarking, NW processing does not support the overwriting of audio codes 
that are present in the stream before the watermarking process begins. Instead, the 

Note: Clicking Reset reverts the values to the default profile.
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watermark engine leaves space for a second (and possibly a third) Final Distributor Service 
ID in the program band.

To configure watermarking on audio output:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 In the Audio Programs section, go to the Watermarking column for the audio program 
you want to configure and click Add.
The Watermark pop-up dialog appears for that audio program.

3 Using the Watermark Type drop-down list, select Nielsen.
The Nielsen watermarking pop-up dialog appears.

4 Using the Process Type drop-down list, select one of the following:
• N2
• NW
• Both

5 In Service ID field, enter the Nielsen channel ID number.
6 In the Check Digit field, enter the two-letter Nielsen check digit. 
7 Using the Distribution Type drop-down list, select one of the following:

• Program Content
• Final Distributor
• Unknown Distribution

Click OK to store the Nielsen settings and close the popup.
8 In the Audio Programs section, the Watermark column displays a Nielsen button for the 

edited audio program.

Note: Audio watermarking is a licensed feature. If your playout server 
does not have the required license the Watermark button will not be 
visible on your Output Server 2 service. See License Requirements on 
page 12.
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9 Click Save to store your changes and automatically reboot the Output Server 2 service. 
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Configuring Voice Overs Playback
You must select to which audio program you want scheduled voice overs to be applied. 
There are no language tags for voice over and only the first source program is used. 

For each combination of channel types, source voice over programs are mapped to a 
specific mode on output. For example, a Dolby 5.1 voice over on a stereo output program is 
down mixed. The one exception is stereo voice overs to a Dolby 5.1 surround output, which 
can be mapped to one of four different modes by the user. Output Server 2 allows you to 
specify the stereo voice over to Dolby 5.1 output mapping at both a channel and a global 
level. 

Figure 7-1 below illustrates how each mapping mode (both the fixed and the user 
selectable) handles the source and output audio:

Fig. 7-1: The fixed and selectable voice over source and output mapping modes.

Note: Voice over configuration, stereo to 5.1 mapping and playback are 
licensed features. If your playout server does not have the required 
license the Voice Over checkbox and will not be visible on your Output 
Server 2 service. See License Requirements on page 12.
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Applying Scheduled Voice Overs to Audio Programs
To apply scheduled voice overs to audio programs:

1 Open the Output Server 2 user interface:
a On the playout server, expand the instance of Output Server 2 for the channel to 

be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 Check Apply VO for an audio program.
3 You should now configure Dolby metadata for your audio programs. See Configuring 

Dolby Metadata on page 57.
Alternatively, click Save to store your changes and automatically reboot the Output 
Server 2 service. 

Mapping Stereo Voice Overs to Dolby 5.1 Outputs
The stereo to 5.1 voice over mapping is a single configuration that applies to all audio 
programs configured for that channel, not individual audio programs. It can be applied at 
either a channel level or a global level from any Output Server 2 service within the same iTX 
domain.

To configure stereo to 5.1 mapping for voice overs:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 On the right hand side, click Additional Config. 
The Additional Config panel appears.

3 Select a level at which to apply the configuration:
• The Global tab allows you to set the voice over mapping for all instances of Output 

Server 2 running in the same iTX domain.
• The Channel can be set to either use the global configuration or a channel-level 

override.
4 Use the drop down list to select a mapping mode from the following:

• Global (Channel tab only): If the Channel tab is set to Global it means the voice 
mapping for this instance of Output Server 2 is using the settings specified on the 
Global tab.

• Centre sum: The sum of the left and right channels are used produce a mono 
output on the center channel.

• Left and Right: The left and right channels from the source are mapped to the 
left and right channels on the output.
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• Left and Right and Center: The stereo source is upmixed and spread among 
the left, right and center output channels.

• Upmix: The source audio is upmixed spread among all of the output channels (i.e. 
surround).

5 Now define the substitution rules for your audio programs. See Defining Substitution 
Rules for Audio Programs on page 56.
Alternatively, click Save to store your changes and automatically reboot the Output 
Server 2 service. 

Assigning Audio Programs to Audio Output Program Groups
Once the audio programs have been created, they must all be assigned to audio program 
output groups. The output channels of the selected rule must be compatible with the audio 
type of the destination output program group. For example, if the audio program is set to 
5.1 or 7.1, it cannot be assigned to an output group set to RAW, as RAW can only hold two 
(stereo) channels.

When you access the Audio tab for the first time it includes a default output, the 
configuration of which depends on whether the instance of Output Server is for a new 
channel or an existing one, which already had an audio configuration before being 
upgraded Output Server 2 v2.8 or later:

• For a new channel: 
• The Default audio program is assigned to an output group, using a type of PCM. 

• For an existing channel: 
• Output groups are created using the audio programs that were created from the 

existing audio configuration.
• The first audio program in the first output group will have Apply VO checked.

The steps below explain how to create a new output group.

To assign an audio program to an output group:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 In the Audio Output Program Group section, appropriate Output tab.
3 Click the drop-down list in the blank Type cell and select one of the following:

• RAW passes audio to the output without any decoding/encoding and uses the 2.0 
channel type only.

• PCM which has the channels 1, 2.0, 5.1 and 7.1 available.
• DolbyD which has the channels 2.0 and 5.1 available.
• DolbyE which has the channels 5.1, 5.1+2.0 (in that order) and 2.0+2.0 available.
• Dolby D Plus which has the channels 2.0, 5.1 and 7.1 available.
• MPEG which has the channels 1 and 2.0 available.
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• AAC which has the channels 1, 2.0, 5.1 and 7.1 available.

4 (Optional) If you have the Dolby metadata license and selected Dolby E as the type, in 
the Settings column the Edit button becomes available. This allows you to set the 
Dolby E bit depth for the audio output program group. By default, this is set to 20-bit.

a Click Edit. The Dolby E Settings dialog appears.
b Click on the Bit Depth drop-down list to change the value.

Alternatively, click Reset to restore the default value.
c Click OK to confirm your settings and close Dolby E Settings dialog.

5 (Optional) If you have selected MPEG as the type in the Settings column the Edit 
button becomes available. This allows you to set the MPEG Bitrate for the audio output 
program group. By default, this is set to 128 kbits/s.

a Click Edit. The MPEG Settings dialog appears.
b Click on the Bitrate drop-down list to change the value.

Alternatively, click Reset to restore the default value.
c Click OK to confirm your settings and close MPEG Settings dialog.

6 (Optional) If you have selected AAC as the type in the Settings column the Edit button 
becomes available. This allows you to configure several AAC settings for the audio 
output program group.

a Click Edit. The AAC Settings dialog appears.
b Click the Version drop-down list to change the value. The default value is MPEG4 

ISO 14496-3.
c Click the Profile drop-down list to change the value. The default value is Low 
Complexity (AAC-LC).

d Click the Bitrate drop-down list to change the value. The default value is 
64 kbit/s.

e Click the Header type drop-down list to change the value. The default value is 
ADTS.

f Click OK to confirm your settings and close AAC Settings dialog.
7 If the Audio Output Program Group is targeting an IP output, then the PID cell appears. 

You must enter a unique non-zero numerical value.
8 Click Save to store your changes and automatically reboot the Output Server 2 service. 

Note: As RAW audio is output without being decoded or encoded, consider 
the following points before selecting this option:
• Compressed PCM audio cannot be output for RAW. Any media with PCM 

audio must be uncompressed to playout using RAW.
• RAW audio cannot be overlaid with voice overs, even if Apply VO is 

checked for the audio program.
• An audio output program group set to RAW must be assigned an audio 

program with unique labels that are not used by any other audio program.
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9 Click on an audio program Name cell, then drag and drop the selected audio program 
to the blank Programs cell in the Audio Output Program Groups section.

If you selected DolbyE as the audio type, you can add up to two audio programs 
(depending on their selected output channels).
When you have added audio programs to the output group, the Description cell 
updates to show the audio type and output channels of the output group.

10 Click Save to store your changes and automatically reboot the Output Server 2 service. 
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Adding logical audio programs and groups to live assets
As live events are not imported and analyzed by FPP, they are not automatically assigned 
audio output program groups. Therefore, you must add logical audio program groups to 
each live asset in your system. This is performed from the property editor, within the Asset 
layout in iTX Desktop.

To add logical audio programs and groups to live assets:
1 Launch iTX Desktop and switch to the Asset layout.
2 From PinPoint, click  to restrict the search results to live assets.
3 Type in the criteria for the live asset you want to update.

Note: Some downstream audio processors may require mono audio 
program groups to be assigned in pairs, as they expect to receive the audio 
signal in pairs.

If your downstream audio processors are capable of handling individual 
mono audio program groups, this consideration can be ignored.

Note: If the combination of the selected audio program’s output channel 
and the output group’s audio type are incompatible, the Program cell turns 
red and the Description cell displays an error, explaining why the selected 
combination cannot be used together.

To correct this error, either change the output group’s audio type or the 
selected audio programs. See Managing Audio Registration, Output and 
Substitution on page 102.
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4 Press the Enter key or click  to begin the search.
5 From the results grid, select the required live asset.
6 In the property editor, click on the Asset tab.
7 On the Logical tab, click Edit. 

The Audio Program Groups Editor appears.
8 Click Add Group.

A new audio group appears at the bottom of the editor.

9 Click the Encoding drop-down list and select one of the following:
• PCM (Default)
• Dolby D
• Dolby E
• Dolby D Plus

10 Click on the Channel drop-down list and select one of the following:
• Mono
• Stereo
• 5.1
• 7.1

11 Double-click on the Label cell. 
The Label Selector appears.

12 Select a label for the audio program and click OK.
13 (Optional) If you selected Dolby E as the encoding method, you can add multiple audio 

programs to the group until all of the channels are assigned (for example a surround 
5.1 and a stereo 2.0 combination).

a Click Add Program to insert an additional audio program. 
b Follow step 10 to step 12 to define the additional audio program.

14 (Optional) To add more audio program groups to the live asset, repeat step 8 to step 13.
15 Click OK to close the Audio Group Editor dialog.

Your live asset is now ready to be used in schedules.
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Configuring Splice Insert Processing
The video signal to the video/audio I/O card in the playout server can contain splice inserts, 
such as SCTE 104 messages (also known as digital cue tones). iTX can detect such messages 
and respond to them to start the playout of a sequence that is on hold in a schedule or end 
a sequence iTX is currently playing. SCTE refer to the time space provided by broadcasters 
to trigger these sequences as the “avail”. Output Server 2 gives users the ability to enable 
and disable individual SCTE 104 features independently, depending on their requirements.

Summary
About SCTE Splice Insert plugins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69
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About SCTE Splice Insert plugins
There are two sides to configuring SCTE104 splice inserts: the features you want to use 
need to be configured in the Splice Insert tab on the Output Server 2 Configuration panel, 
while the message types need to be configured via one of two different plugins in the iTX 
Desktop.

Plugin Description

VANC 
plugin

The VANC plugin is the legacy SCTE104 solution, which supports the following 
features:
• The ability to react to inbound splice request commands sent in a Multiple Operation 

Message, providing they are the only command in the Multiple Operation Message.
• Pass-through of splice request commands to downstream services. Any unsupported 

commands are stripped from the message. 
• Insertion of outbound splice commands.
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Configuring Splice Insert Features 
To configure Splice Insert features for Output Server 2:

1 On the playout server, expand the instance of Output Server 2 for the channel to be 
configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Go to Configuration > Splice Insert.
3 Check Splice Insert Trigger Enabled.

As well as enabling splice insert triggering, checking this options makes the following 
splice insert features available:

• Heartbeat
• Inbound Triggers
• Break Trigger Type

4 To enable the passing of null splice insert messages for heartbeating to downstream 
services, click Heartbeat Enabled. 
This option is only supported by the SCTE104 plugin.

5 In the Output Line Number field, enter the vertical ancillary (VANC) line number on 
which to output splice inserts. 

6 To enable pass-through to downsteam services, check Pass-Through Enabled.
This option is only supported by the SCTE104 plugin.

7 To have incoming messages passed through on the selected output line number, check 
Pass-Through on Output Line.

8 To perform partial or full replacement of splice event inbound  splice inserts, enter a 
value in Event Mask. 

SCTE104 
plugin

The SCTE104 plugin supports the following enhanced features:
• The ability to react to inbound Multiple Operation Messages containing more than one 

command, including:
• Splice request commands.
• Local and National Avail Insert Commands, either individually or both in the same 

Multiple Operation Message.
• Legacy DTMF triggers.

• Enhanced message pass-through, which provides the following additional functionality:
• All inbound SCTE104 messages can be either passed through or blocked.
• When pass-through is enabled, iTX allows for the passing of “NULL” SCTE messages for 

heart-beating to downstream services.
• The ability to enable or disable pass-through for all commands within a Multiple 

Operation Message. 
Splice commands received outside of a configured available window are unchanged.

• Insertion of outbound Multiple Operation Messages containing the following additional 
commands:
• Local and National Avail Insert Commands, either individually or both in the same 

Multiple Operation Message.
• Legacy DTMF triggers.

Plugin Description
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The mask configuration allows for bit level "OR" masking. For example:

This option is only supported by the SCTE104 plugin.
9 To set the delay TXPlay 2 allows before it responds to Start Sequence and End 

Sequence messages, enter a value in Delay (Frames).
10 Enable the required Inbound Triggers by checking any of the following options:

• If you want the channel to process spliceStart_normal insert commands, enable 
Sequence Start. 

• If you want the channel to process spliceEnd_normal insert commands, enable 
Sequence End.

• If you want the channel to process spliceStart_immediate insert commands, 
enable Immediate Sequence Start. 
These commands can be used to start a sequence early, but their usage is not 
recommended by SCTE 35 [1] and may result in inaccurate splices.

• If you want the channel to process spliceEnd_immediate insert commands, 
enable Immediate Sequence End. 
These commands can be used to terminate a sequence early, but must include the 
correct event ID for the sequence that is to be canceled.

All message types can be enabled at once, if required.
11 Enable the required Break Trigger Types by enabling or disabling the following 

options:
• National Breaks
• Local Breaks

The table below describes the effects from various combinations of these two options:

Incoming message (hex): 0x00005c7e

Inputted Event Mask string (dec): 1073741824

Actual Event Mask (hex): 0x40000000

Output (hex): 0x40005c7e

Combination Result

National Breaks disabled
Local Breaks disabled

iTX will trigger in all cases, i.e. when it receives Multiple 
Operation Messages with:
• Only a splice_request_data command (legacy SCTE104)
• Both a splice_request_data and a 
segmentation_descriptor_request (for either local or 
national breaks).

NOTE:
If you are only using the legacy VANC plugin, both break 
trigger types must be disabled.

National Breaks enabled
Local Breaks disabled

iTX will only trigger if a Multiple Operation Message is 
received with a splice_request_data and a 
segmentation_descriptor_request with the 
segmentation_type_id set to National (value 0x32). 
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12 Click Save to store your changes and automatically reboot the Output Server 2 service. 
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Configuring the SCTE104 Message Types
In addition to the configuration that has to be performed in the Output Server 2 user 
interface, the following configuration needs to be performed within iTX Desktop. The 
required configuration is dependent on whether you are using just the legacy features or 
both the legacy and enhanced features.

Configuring the legacy VANC plugin
For channels that will only process legacy SCTE104 messages:

• In Engineering > Channel Config > Plugins > VANC specify:
• Insert Type (select SPLICER)
• Automatic System Index
• Duration (Frames)

For more information see the iTX System Administration Guide.

Configuring enhanced SCTE104 plugin
For channels that will process both legacy and enhanced SCTE104 features:

• In Engineering > Channel Config > Plugins > SCTE104 specify:
• Insert Type
• Automatic System Index
• Duration (Frames)

For more information see the iTX System Administration Guide.

Configuring sequences for SCTE104
A sequence is a small group of schedule events that iTX handles as a single event block. A 
typical sequence might contain a few video clip events and secondary events, with certain 

National Breaks disabled
Local Breaks enabled

iTX will only trigger if a Multiple Operation Message is 
received with a splice_request_data and a 
segmentation_descriptor_request with the 
segmentation_type_id set to Local (value 0x30). 

National Breaks enabled
Local Breaks enabled

iTX will only trigger if a Multiple Operation Message is 
received with a splice_request_data and a 
segmentation_descriptor_request with the 
segmentation_type_id set to Local (value 0x30) or 
National (value 0x32). 

Combination Result
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transitions or vision effects. As such, sequences can be used to schedule a block of 
advertisements or trails, triggered to start and stop by SCTE104 messages.

• For sequence control via SCTE104 messages, in the Event Editor for the sequence 
enable the Allow External Takes.

• For scheduled break sequences on the inbound channel:
• In Engineering > Channel Config > Channel Config 2, the Fixed Availability 

Windows is used to control how the start and end times for a sequence are 
interpreted. 
When enabled, the Start Window and End Window times for sequences are 
applied as specified in the Event Editor for the item. The Start and End Window 
times include the time and date for the item.
When disabled, the Start Window and End Window times for sequences are 
applied relative to the start time of the item. 

• In Event Editor for the sequence item: 
• Specify the sequence’s availability window by entering timecodes in the Start 

Window and End Window fields. 
How these times are interpreted is dependent on the Fixed Availability 
Windows option in Channel Config 2.

• If required, enable SCTE104 LocalAd. 
iTX inserts an SCTE 104 message to trigger the insertion of local advertisement. 
It does this when it plays out a sequence as a result of receiving an SCTE 
message containing a delay.
Unless you require this specific functionality, you should ensure the option is 
not selected.

For more information on configuring availability windows see the iTX System Administration 
Guide.

For more information on working with sequences see the iTX Desktop Operator Guide.

Note: Once an availability window has been set and applied it cannot be 
removed. If the availability window is changed, the new window will take 
effect, but the previous window will not be removed until the Output Server 
2 service is restarted.
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Configuring Optional Plugins and 
Functionality
Not all of iTX’s functionality is mandatory and as such some aspects of Output Server 2 only 
need to be configured if you require the associated functionality or have purchased the 
corresponding software license and (if applicable) hardware. This section explains how to 
configure these optional plugins and functionality.

Summary
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Configuring Subtitle Playout
From v2.8 onwards, iTX includes the ability to playout subtitles using Grass Valley Softel 
Inside. This functionality is optional and therefore no basic configuration is required if you 
do not want to use Softel Inside for your subtitling solution. 

If you are using Softel Inside, see the iTX Softel Inside Configuration & User Guide for more 
information.

Playing Out Legacy Subtitles or Closed Captions on iTX v2.8 or Later
If you had been playing out basic subtitles or closed captions on a previous installation of 
Output Server 2, you would have had to configure one stream and one service. As of iTX 
v2.8 or later, legacy subtitles and closed captions no longer require this baseline 
configuration and therefore it must be removed from the Output Server 2 user interface.

To remove the previous baseline subtitle configuration for legacy subtitles:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Go to Configuration > Subtitles tab. 
3 Expand the Services tab.
4 From the Service drop-down list, select each service you have configured and click 

Remove.
5 Expand the Streams tab.
6 From the Streams drop-down list, select each stream you have configured and click 

Remove.
7 Click Save. Output Server 2 will automatically shut down and restart to apply your 

changes.
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Configuring iTX Desktop for 4K CGs and Logos
If you are operating a 4K channel and using the iTX CG or Logo plugin, you must instruct 
your iTX Desktop PCs to enable the 4K version of CG and Logo canvas. This is done by 
adding an environment variable to Windows. 

This environment variable can be assigned to either the currently logged in user or to all 
users, as a system variable. The steps below explain how to add the 4K Desktop 
environment variable at a system level.

To create the Windows environment variable for the 4K Desktop:
1 On the iTX Desktop PC, press +R. 

The Run dialog appears.
2 In the Open field, type sysdm.cpl. 

The System Properties dialog appears.
3 Click Advanced, then Environment Variables.

The Environment Variables dialog appears.
4 In the System Variables section, click New.

The Edit System Variable dialog appears.
5 Enter the environment variable as follows:

• In the Variable Name field, enter ENABLE_4K_DESKTOP.
• In the Variable Value field, enter 1.

6 Click OK to close the Edit System Variable dialog. 
On the Environment Variables dialog, the new variable is listed in the System Variables 
section.

7 Click OK to close the Environment Variables dialog.

Viewing the XG Inside Status
If you have XG Inside and multiple channels configured on the same playout server, you can 
view which XG Inside channel has been assigned to an instance of Output Server 2 from the 
Channel tab of the Output Server 2 user interface.

To view the XG Inside channel status:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Go to Configuration > Channel tab. 
The XG Inside Channel parameter is listed among the other channel configuration 
settings. 
If this setting is grayed out it means you do not have the necessary software installed 
on your playout server. 

For more information about configuring Vertigo XG Inside, see the Vertigo XG Inside User 
Guide.
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About Custom Aspect Ratio Control (ARC) Modes
In the Channel Config layout of iTX Desktop, the Advanced Aspect Ratio Control panel 
allows you to map a scheduled item’s field values to an output aspect ratio, ARC mode and 
Active Field Description (AFD). For channels that are operating on Output Server 2 you can 
also define custom ARC modes. When defining a custom ARC, you can alter the following 
properties in both the input and the output picture:

• Aspect ratio (default 16:9)
• Vertical size (default 100%)
• Horizontal size (default 100%)
• Tilt position (default 0.00%)
• Pan position (default 0.00%)

Reducing the input Vertical or Horizontal percentages crops the picture equally on each 
side, while reducing the output Vertical or Horizontal percentages zooms the picture out 
equally on each side. For example, a Horizontal input value of 80% will crop 10% from the 
left and right sides of the picture. 

It is also possible to lock the aspect ratio to the values of your choice. For example, if 
Horizontal is set to 100% and Vertical is set to 54.05% (creating a 1.85:1 aspect ratio), 
checking Lock Aspect Ratio means if you change a Horizontal value to 90%, the 
corresponding Vertical value automatically changes to 48.65%, maintaining the 1.85:1 
aspect ratio.

Reducing a Vertical value also allows you to adjust the corresponding Tilt value. The Tilt 
range is determined by the Vertical value. For example, if a Vertical value is reduced to 90%, 
the Tilt range will be -5.00% to +5.00%, with 0.00% being center. 

Reducing a Horizontal value allows you to adjust the corresponding Pan value. The Pan 
range is determined by the Horizontal value. For example, if a Horizontal value is reduced to 
75%, the Pan range will be -12.50% to +12.50%, with 0.00% being center. 

As the percentages are changed, preview windows automatically update to show what area 
of the input picture will be used and the effect on the output picture. Figure 9-1 below to 
Figure 9-4 on page 78 show the preview windows for some example custom ARC modes.

Fig. 9-1: The Input values are set to Vertical 90% and Horizontal 90%, as illustrated by the area within 
the red border. The Output values are set to default. The resulting output picture is cropped evenly on 
all sides.
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Fig. 9-2: The Input values are set to Vertical 80% and Tilt -10%, as illustrated by the area within the red 
border. The Output values set to default. The resulting output picture only shows the top 80% of the 
input picture.

Fig. 9-3: The Input values set to default, so the whole picture is kept within the red border. The Output 
set to Vertical 90%, Horizontal 90%, Tilt -5% and Pan -5%. The resulting output picture is zoomed out 
and displayed in the top-left corner, with a border along the bottom and right.

Fig. 9-4: The Input values are set to Horizontal 75%, as illustrated by the area within the red border; 
Output set to Aspect Ratio 4:3. The resulting output picture is horizontally cropped and displayed 
with a 4:3 aspect ratio.

Defining a Custom Aspect Ratio Control (ARC) Mode
Custom ARC modes are defined from the Advanced Aspect Ratio Control - Mapping 
Configuration pop-up layout, in the Channel Config layout. When you apply a custom ARC 
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mode, it takes effect on the next asset in the schedule with AFD settings that correlate to 
that mode.

To access the Custom Aspect Ratio Control Mode dialog:
1 Start the iTX Desktop on a client PC and login with an Administrator profile.
2 Open the Engineering layout.
3 Click Channel Config. 

The Channel Config pop-up layout appears.
4 From the View list, select the view containing the channels to be configured. The 

channels associated with that view appear.
5 Click the name of the channel to be configured.
6 Click the Channel Config 4 tab.
7 In the Advanced Aspect Ratio Control panel, click Configure Mapping...

The Advanced Aspect Ratio Control - Mapping Configuration pop-up layout appears.
8 Click Define Custom ARC Mode...

The Customer Aspect Ratio Control Mode dialog appears.

Note:
• The Advanced ARC and AFD-insertion features are only available if your 

system has the necessary software license. Your system may be licensed to 
use the functionality for both of these in one license. Configuring the 
settings for unlicensed functionality does not affect the output video 
signal. 

• The mapping configuration dialog is intended to provide the maximum 
flexibility for the setting up of ARC operations and AFD insertion. The 
dialog does not prevent you from setting unsuitable configurations (for 
example, selecting a 4:3 aspect ratio for an HD channel). 
To prevent problems with the display of the video image, ensure the 
configuration settings are correct for each channel in your iTX system. 

• For information on editing and deleting custom ARC, see Maintaining 
Custom Aspect Ratio Control (ARC) Modes, on page 106.
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9 In the Customer Aspect Ratio Control Mode dialog, click New.
A new set of default ARC values appear with the name new-custom-mode-(n), where 
(n) is a unique number.

10 In the Name field, enter a unique name to identify the new custom mode. 
11 In the Input section. define the area to use from the input picture:

a Select an input Aspect Ratio from either 16:9 (default) or 4:3.
b Configure the size of the area to use from the input picture. 

• For the Vertical size, enter a percentage or drag the slider to crop the picture 
vertically. 

• For the Horizontal size, enter a percentage or drag the slider to crop the 
picture horizontally. 

• If you want the two percentages to move in relation to each other, check Lock 
Aspect Ratio.

c Configure the position of the area to use from the input picture:
• If the Vertical percentage has been reduced, you can adjust the Tilt value by 

entering a percentage or dragging the slider. 
• If the Horizontal percentage has been reduced, you can adjust the Pan value 

by entering a percentage or dragging the slider. 
As the percentages are changed, both preview windows automatically update to show 
the effect.

12 In the Output section, define the ARC for the output picture:
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a Select an output Aspect Ratio,
b Configure the size of the output picture. 

• For the Vertical size, enter a percentage or drag the slider to zoom out the 
picture vertically. 

• For the Horizontal size, enter a percentage or drag the slider to zoom out the 
picture horizontally. 

• If you want the two percentages to move in relation to each other, check Lock 
Aspect Ratio.

c Configure the position of the output picture:
• If the Vertical percentage has been reduced, you can adjust the Tilt value by 

entering a percentage or dragging the slider. 
• If the Horizontal percentage has been reduced, you can adjust the Pan value 

by entering a percentage or dragging the slider. 
As the percentages are changed, the Output preview window automatically updates to 
show the effect.

13 Click Save then Close.
You are returned to the Advanced Aspect Ratio Control - Mapping Configuration 
pop-up layout. From here you can assign your new custom ARC to a set of field values. 
See Assigning a Custom Aspect Ratio Control (ARC) Mode below.

Assigning a Custom Aspect Ratio Control (ARC) Mode
Both standard and custom ARC modes are assigned to a ARC operation in the same way.

To assign a custom ARC mode:
1 Open the Advanced Aspect Ratio Control - Mapping Configuration dialog
2 Decide which set of field values you want to remap and click the corresponding ARC 

Mode button.

The ARC Mode selection dialog appears.
3 Select your new ARC mode from the Custom ARC modes list then click OK.

On the Advanced Aspect Ration Control - Mapping Configuration dialog, the name of 
the custom ARC mode appears in the ARC Mode column and the corresponding 
Output Aspect Ratio field will change a display only field showing the output aspect 
ratio of the custom ARC mode.

4 Select your required Active Field Description then click OK.
For more information see the iTX System Configuration Guide.

5 On the Channel Config pop-up layout, click Save and Close.

Note: Once an ARC mode and AFD code is mapped to a set of field values, 
the very next scheduled item on the channel with matching field values will 
playout using the new ARC mode and AFD.
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The examples below show the effect on the final picture using different custom ARC input 
and output settings and what happens when you change both the input and the ouput 
settings:
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 I/O Card Connection Reference
This appendix discusses the I/O Device Controller Engineering Panel, which contains the 
schematics for every combination of video/audio I/O card and playout type. This can be 
used as a reference when connecting inputs and outputs to your video/audio I/O card.

Summary
About I/O Device Controller Engineering Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  83
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About I/O Device Controller Engineering Panel
The I/O Device Controller Engineering Panel shows your video/audio I/O cards inputs and 
outputs for your currently selected playout type (in TXPlay 2 Config) and whether they are 
the main or secondary inputs and outputs for the selected playout type. 

The image below shows the Engineering panel for a Corvid 44 set to the dual channel 
playout type:
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Accessing the I/O Device Controller Engineering Panel
The Engineering panel uses the following indicators:

The drop-down menu on the bottom right can be used as a filter to show different inputs 
and outputs individually:

• All 
• None
• Channel A
• Channel B
• Inputs 
• Outputs
• Reference

Accessing the I/O Device Controller Engineering Panel
To access the I/O Device Controller Engineering panel:

1 On the playout server running the service, maximize the Server Controller application. 
If Server Controller is not running, it can usually be found in Start>All Programs>iTX 
2.0.

2 Select the Controlled Services tab. All of the services running on that server are listed. 
3 Double-click I/O Device Controller. 

The I/O Device Controller user interface appears. It includes tabs for Service Details, 
Trace Logs, Installation Info, Configuration and Engineering.

4 Click on the Engineering tab. 
The schematic for your video/audio I/O card appears.

Indicator Description

Output spigot 

Input spigot 

Reference input spigot
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Corvid LP I/O Connections

Corvid LP video/audio I/O cards only support the single channel playout type and have the 
following inputs and outputs: 

Kona 3G I/O Connections

Kona 3G video/audio I/O cards only support the single channel playout type and have the 
following inputs and outputs:

Playout 
type

Port RS-
422 Port R Port 1 Port 2

Single 
channel

- Ref In Ch A 
Output

Main

Ch A
Input
Main

Playout 
Type Port J1 HDMI

Port 
SDI 1

Port 
SDI 2

Port 
SDI 3

Port 
SDI 4

Single 
channel

Ref 
Input

- - Ch A
Input
Main

- Ch A 
Output

Main
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Corvid 44 I/O Connections

Depending on the selected playout type, Corvid 44 video/audio I/O cards uses the 
following inputs and outputs:

Playout 
Type Port 1 Port 2 Port 3 Port 4 Port R

Single 
channel

Ch A
Output

Main

Ch A
Output

Sec

Ch A
Input
Main

- Ref
Input

4K Single 
channel

Ch A
Output
Main 1

Ch A
Output
Main 2

Ch A
Output
Main 3

Ch A
Output
Main 4

Ref
Input

Dual 
channel

Ch A
Output

Main

Ch B
Output

Main

Ch A
Input
Main

Ch B
Input
Main

Ref
Input

Simulcast Ch A
Output

Main

Ch B
Output

Main

Ch A/B
Input
Main

Ch A/B
Input

Second

Ref
Input

Dual Live Ch A
Output

Main

Ch A
Output

Sec

Ch A
Input
Main

Ch A
Input

Second

Ref
Input
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Corvid 88 I/O Connections 

o

Depending on the selected playout type, Corvid 88 video/audio I/O cards use the following 
inputs and outputs:

Playout 
Type Port 1 Port 2 Port 3 Port 4 Port 5 Port 6 Port 7 Port 8 Port R

Single 
channel

Ch A
Output

Main

- Ch A
Input
Main

- - - Ch A
Output

Sec

- Ref
Input

4K Single 
channel 

Ch A
Output
Main 1

Ch A
Output
Main 2

Ch A
Output
Main 3

Ch A
Output
Main 4

Ch A
Input

Main 1

Ch A
Input

Main 2

Ch A
Input

Main 3

Ch A
Input

Main 4

Ref
Input

Dual 
channel

Ch A
Output

Main

Ch B
Output

Main

Ch A
Input
Main

Ch A
Input

Second

Ch B
Input
Main

Ch B
Input

Second

Ch A
Output

Sec

Ch B
Output

Sec

Ref
Input

Simulcast Ch A
Output

Main

Ch B
Output

Main

Ch A/B
Input
Main

Ch A/B 
Input

Second

- - Ch A
Output

Sec

Ch B
Output

Sec

Ref
Input

Dual Live Ch A 
Output

Main

- Ch A
Input
Main

Ch A
Input

Second

- - Ch A
Output

Sec

- Ref
Input
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Corvid LP + Corvid LP I/O Connections

Depending on the selected playout type, a playout server with dual Corvid LP video/audio 
I/O cards use the following inputs and outputs:

Playout 
type

Device 0 Device 1

Port RS-
422 Port R Port 1 Port 2

Port RS-
422 Port R Port 1 Port 2

Single 
channel

- Ref 
Input

Ch A
Output

Main

Ch A
Input
Main

- - - -

Dual 
channel

- Ref 
Input

Ch A
Output

Main

Ch A
Input
Main

- Ref 
Input

Ch B 
Output

Main

Ch B
Input
Main

Dual live - Ref 
Input

Ch A 
Output

Main

Ch A
Input
Main

- - Ch A
Input

Second

-
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This appendix contains information about the day-to-day operation an Output Server 2 
channel, including simulcast and dual live channel. 

Summary
Managing Audio from iTX Desktop  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  89
About Output Server 2 Channel Status Indicators  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97
Viewing Live Event Inputs on Channel Control Layouts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97

Managing Audio from iTX Desktop
From within iTX Desktop, you can manage the audio configuration of video, voice over and 
live assets in the following ways:

• View both the logical audio program groups and physical track configuration.
• Override the physical audio output channel mapping of videos and voice overs using 

the event properties on either the Content Selector or Event Editor.
• For live assets, you can also reconfigure their logical audio.

Viewing an Asset’s Logical or Physical Audio Mapping
Both the logical audio program groups and the physical audio mapping for video, voice 
over and live assets can be viewed from the property editor’s Logical and Physical tabs on 
the Asset layout. For video and voice over assets, these tabs can be found on the Locations 
tab, while for live assets they are on the Asset tab.

Figure B-1 on page 89 shows the Logical tab of a video asset and Figure B-2 on page 90 
shows the Physical tab of the same asset.

Fig. B-1: The Logical sub-tab shows the structure of the audio program groups for the selected asset.
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Editing the logical audio programs and groups for a live asset
Fig. B-2: The Physical sub-tab shows the arrangement of audio tracks within the media file. 

To view an asset’s audio mapping:
1 In iTX Desktop, switch to the Asset layout.
2 From PinPoint, select one of the following filters:

• To restrict the search results to video assets, click .
• To restrict the search results to voice over assets, click .
• To restrict the search results to live assets, click .

3 (Video and voice over assets only) From the filter at the top of PinPoint select Media > 
Has Logical Audio.
The filter is now set to Has Logical Audio | Yes.

4 Type in the criteria for the asset you want to update.
5 Press the Enter key or click  to begin the search.
6 From the results grid, select the required asset.
7 For video and voice over assets, go to the property editor on the right and select the 

Locations tab.
For live assets, go to the property editor on the right and select the Assets tab.

8 Click the Logical and Physical tabs to swap views.

Editing the logical audio programs and groups for a live asset
Using the asset property editor, it is possible to edit the logical audio program groups 
assign to a live asset. Editing the logical audio programs does not affect the physical audio 
configuration.

To edit the logical audio of a live asset:
1 Search for a live asset, as described in Viewing an Asset’s Logical or Physical Audio 

Mapping.
2 On the Logical tab, click Edit. 

The Audio Program Groups Editor appears.
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3 To change how the asset is encoded, click the Encoding drop-down list and select one 
of the following:

• PCM 
• Dolby D
• Dolby E
• Dolby D Plus

4 To change which channels the audio is output on, click on the Channel drop-down list 
and select one of the following:
• Mono
• Stereo
• 5.1
• 7.1

5 To change the current audio program label, double-click on the Label text. 
The Label Selector appears.

6 Select the label for the audio program and click OK.
7 (Optional) If you selected Dolby E as the encoding method, you can add multiple audio 

programs to the group until all of the channels are assigned (for example a surround 
5.1 and a stereo2.0 combination).

a Click Add Program to insert an additional audio program. 
b Follow step 3 to step 6 to define the additional audio program.

8 Click OK to close the Audio Group Editor dialogue.

Removing a logical audio program or group from a live asset
Using the asset property editor, it is possible to remove unwanted logical audio programs 
and groups from a live asset. 

To configure the logical audio of a live asset:
1 Search for a live asset, as described in Viewing an Asset’s Logical or Physical Audio 

Mapping.
2 On the Logical tab, click Edit. 

The Audio Program Groups Editor appears.
3 To remove a program from an audio group, click on the X next to the program name, as 

shown in Figure B-3 on page 92.
4 To remove an audio group (and all of its programs), click on the X next to the audio 

group name, as shown in Figure B-3 on page 92.

Note: If you are changing a Dolby E program group to either Dolby D, 
Dolby D Plus or PCM, you should remove the unwanted audio program 
before selecting a different method of encoding. See Removing a logical 
audio program or group from a live asset on page 91.
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Fig. B-3: Removing audio programs and groups via the Audio Group Editor dialog.

5 Click OK to close the Audio Group Editor dialog.

Editing physical audio tracks for a live asset
The Physical audio tab displays details of the individual physical audio tracks of a selected 
live asset, which includes two properties that you can modify: the language tag and the 
compression method.

To edit the physical audio tracks for a live asset:
1 Search for a live asset, as described in Viewing an Asset’s Logical or Physical Audio 

Mapping.
2 On the Physical tab, click Edit. 

The Audio Tracks Mapping dialog appears.

3 To add an audio track, click .
A new row appears, with the next available ID number.

4 Double-click on the Language cell.
The Language Selection dialog appears.

5 To add a language tag, select the language tag you require from the Available 
Language Codes column the click . 
The selected language is added to the Selected Language Codes column.

6 To remove the language tag, select the language tags you require from the Selected 
Language Codes column the click . 
The selected language is added to the Available Language Codes column.
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7 Click OK to close the Language Selection dialog.
8 Click on Compression and select one of the following from the drop-down list:

• PCM mono
• PCM stereo
• Dolby D 5.1
• Dolby D 2.0
• Dolby E 5.1+2
• Dolby E 5.1
• Dolby D Plus 2.0
• Dolby D Plus 5.1
• Dolby D Plus 7.1

9 (Optional) To add more audio tracks, repeat step 3 to step 7.
10 (Optional) To remove an existing audio track, select the track then click .
11 Click OK to confirm your settings and close the Audio Track Mapping dialog.

Managing physical audio tracks for a video clip 
The Physical audio tab displays details of the individual physical audio tracks of a selected 
video clip, which includes two properties that you can modify:

• The group to which a mono track belongs. iTX can use mono tracks in the same group 
to produce a PCM stereo or Dolby E output signal.

• A language tag, which identifies the language of the audience the track is intended for.

To modify the properties, you use the Audio Track Mapping dialog, which is access from the 
Edit button on the Physical tab.
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Grouping mono tracks
Usually iTX automatically adds track grouping information to an asset when it ingests the 
broadcast quality file. This can be controlled in Delivery Manager within the end point 
configuration. See the iTX Delivery Manager Setup Guide for more information.

The following procedure is only applicable when this has not happened.

To manually group mono tracks:
1 Search for a video asset, as described in Viewing an Asset’s Logical or Physical Audio 

Mapping.
2 Open the Locations tab, select the Physical tab.
3 Click Edit. 

The Audio Track Mapping dialog appears.
4 Select tracks you want to group.
5 Click the button that denotes the output format that the mono tracks can be used to 

produce (i.e Dolby E 5.1 + 2, Dolby E 5.1, or PCM Stereo). 
6 Click OK to close the dialog.

Adding language tags to tracks

Add a language tag to a track
1 In iTX Desktop, switch to the Asset layout.
2 Search for and select an asset using PinPoint.
3 Open Locations tab, then select the Physical tab.
4 Click Edit. 

The Audio Track Mapping dialog appears.
5 Click on a Language box. 

The Language Selection dialog appears:

Note: You can use the Audio Track Mapping dialog to reverse the automatic 
grouping iTX performs on ingest; to do so, you change a track marked as 
PCM Stereo or Dolby E to mono.
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6 You can change the selected languages in the following ways:
• To add a language to the audio track, select a language from the Available 

Language Codes column, then click the right arrow button  to add it to the 
Selected Language Codes. 

• To remove a language from the audio track, select a language from the Selected 
Language Codes column, then click the left arrow button  to return it to the 
Available Language Codes.

7 Click OK to close the Language Selection dialog.
8 The Audio Track Mapping dialog now displays the name of the selected language in 

the Language box.
9 Click OK to close the Audio Track Mapping dialog.

Overriding Audio Output Channels
iTX can deliver the audio content of a voiceover clip or a video clip event on up to 16 PCM 
output channels. This mapping is derived from the configuration in the Audio tab of the 
Output Server Configuration user interface. See Configuring Audio Output on page 53.

If required, it is possible to override the audio output channels in the event properties and 
associate the channels with output pins. For voice overs, the first audio track in the file 
should be on the outputs that contain the specified channels. 

For example, if you want channels 1 and 2 of a voice over on the first output, you would 
enable Pin 1.
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Overriding Audio Output Channels
Editing output pins of an event before adding it to a schedule

To edit the output pins of a video clip, voice over or live asset before adding it to a 
schedule:

1 Go to the Content Selector for Video Clips, Voice Overs or Live.
2 Select an asset to modify from the Selected Clips, Selected Audio Clips or Live Sources 

pane.
If the required asset is not loaded, click Search to locate it using PinPoint.

3 Click the Properties button .
The Properties dialog appears, which contains a Select output pins section.

4 Select the required pins, as described in Overriding Audio Output Channels above.

Editing output pins of events in schedules

To edit the output pins of a video clip, voice over or live event that is in a schedule:
1 In the Schedule Grid, select a Video Clip, Voice Over or Live event to modify.
2 In the Content Selector, click the Properties button .

The Properties dialog appears, which contains a Select output pins section.
3 Select the required pins, as described in Overriding Audio Output Channels above.

IMPORTANT

To use the audio mapping rules defined in the Audio tab of the Output 
Server Configuration user interface, no pins should be selected. This is 
the default setting.
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About Output Server 2 Channel Status Indicators
The table below describes the indicators that may appear on top of the Schedule Grid for 
an Output Server 2 system:

Viewing Live Event Inputs on Channel Control Layouts
The input each live event is coming from can be viewed from the timeline in iTX Desktop.

To view the live event input:
• While a live event is on air, hover your mouse cursor over the event block on the 

timeline. The pop-up tooltip shows information about the event in focus, including its 
input (at the bottom).

Indicator Description

 

In a leader/follower system, this indicator appears for the leader (main) 
channel. 

 

In a leader/follower system, this indicator appears for any of the follower 
channels. This includes:
• Backup channels
• Simulcast channels
• Simulcast backup channels.

In an simulcast system, this indicator appears on simulcast and simulcast 
backup channels, alongside the Follower label.

In a system with a matrix router, this indicator appears when the channel 
output is routed to a destination to which the transmission system is 
connected.

Note:
• Channel control and schedule changes cannot be performed on Follower 

channels.
• During transition from Output Server 1 to Output Server 2, Output Server 

1 master channels will display a Master indicator and their Output Server 
2 slave channels will display a Follower indicator.
97



Operating an Output Server 2 System
Viewing Live Event Inputs on Channel Control Layouts
98



Maintaining an Output Server 2 System
This appendix contains information about how to maintain an Output Server 2 system. This 
includes the location of log files, the OS2 Engineering panel, changing Output Server 2 
configuration and changing system configuration that is outside of Output Server 2, but 
which affects the way it operates.

Summary
Starting Output Server 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  99
Configuring Media Cache 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
Managing Audio Registration, Output and Substitution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Honoring NTSC SD Field Orders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
Maintaining Custom Aspect Ratio Control (ARC) Modes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
Deleting a Channel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
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Viewing the Output Server 2 Engineering Panel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
About Logging for Output Server 2  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112

Starting Output Server 2
As iTX services, Output Server 2, TXPlay 2, the I/O Device Controller and Media Cache 2 are 
controlled by the Server Controller application, which is installed with any iTX component. 
When the Server Controller is started, all of the services installed on the playout server are 
started, one after another. If a service is shut down, Server Controller can restart them 
automatically to protect system integrity.

Through Server Controller, Output Server 2 can be configured to control the way it starts, 
the channels it runs and the way those channels are setup.

To start Server Controller: 
• Go to Start > All Programs > iTX 2.0 > Server Controller.

The Server Controller appears and loads all of the installed services in their current 
configuration.
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Configuring Media Cache 2 
The Media Cache service window includes a Configuration tab, for controlling caching 
thresholds, playback from the NAS and selecting which Media Watcher and domain to use.

Setting the Caching Thresholds
There are two fields for controlling the caching thresholds, one for the maximum transfer 
speed and one for the maximum block size.

To change the caching thresholds:
1 On the playout server running the Output Server 2 system, expand the I/O Device 

Controller. 
The I/O Device Controller user interface appears. 

2 Click the Configuration tab. 
The Configuration panel appears.

3 Enter a value in the Max Transfer Rate (MB/s) field to select the maximum caching 
speed, up to 1024MB/s (or 8.192 Gbit/sec). 
This option defaults to 0 MB/s, which means the speed is uncapped. 

4 Enter a value in the Block Size (MB) field to control the size of the data blocks that are 
written to disk. The default is 8MB. Increasing this value can reduce the amount of 
throttling that is required during caching and improve the overall performance.

5 Click Save.

Controlling Playback from Network Attached Storage (NAS)
When media cannot be cached in time for playout, iTX can resort to playing it from the NAS. 
The success of playing from a NAS depends on several facts, including the speed of your 
network and the bitrate of the media being played. As such, the Media Cache service allows 
you to control playback from the NAS and the maximum media bitrate it will attempt to 
play. This can be useful when you have higher bitrate media, such as DNxHD encoded MXF 
files, which might struggle to play from a NAS.
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To control the playback from a NAS:
1 On the playout server running the Output Server 2 system, expand the I/O Device 

Controller. 
The I/O Device Controller user interface appears. 

2 Click the Configuration tab. 
The Configuration panel appears.

3 Click Enable Playback From NAS to enable or disable playback from NAS.

4 Enter a value in the Maximum Allowed Bitrate (Mb/s) field to limit NAS playback to 
media that is below the specified value.
The default value is 99999Mb/s.

5 Click Save.

Selecting the Media Watcher
The Media Cache service allows you to select which Media Watcher you want to copy files 
from external search folders when they are required for playout. Depending on the search 
folder configuration, the copy destination may be either the Output Server cache or a 
Media Store managed by the Media Watcher.

To select a Media Watcher:
1 On the playout server running the Output Server 2 system, expand the I/O Device 

Controller. 
The I/O Device Controller user interface appears. 

2 Click the Configuration tab. 
The Configuration panel appears.

3 From the Media Watcher box, select the Media Watcher you want to use to copy files 
from external search folders when they are required for playout. 

4 Click Save.

Selecting Search Domains
Through the search domains panel, you can tell a Media Cache service to use a user 
specified search domains list, instead of the central list that you configure in the Media 
Watcher. 

To select search domains:
1 On the playout server running the Output Server 2 system, expand the I/O Device 

Controller. 
The I/O Device Controller user interface appears. 

2 Click the Configuration tab. 

Note: If you set up the Media Cache Service to use a local domain search list, 
you must set up TX Play on the same machine to use an identical list.
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The Configuration panel appears.
3 Click Local to switch the service between using the local configuration and the central 

one.
4 In the Available Domains list, select the domains you want to use, then click >> to add 

them to the Selected Domains list.
5 Click Save.

Managing Audio Registration, Output and Substitution
In addition to the initial configuration of audio programs and output groups, you may want 
to change how your audio is registered, output and substituted. Some of this configuration 
is performed outside of Output Server 2 and the iTX Desktop. This section describes how to 
perform these tasks.

Separating Mono Tracks on Import
By default, Delivery Manager combines mono tracks to create stereo programs on import. 
This option can be enabled or disabled within the Delivery Manager endpoint configuration, 
Once changed, this configuration will only affect newly imported media.

To separate mono tracks in Delivery Manager:
1 From Windows, click START > All Programs > iTX 2.0 > Delivery Manager Config. 

The Select Configuration dialog is displayed.
2 Select a configuration profile and click OK.

The Delivery Manager Configuration dialog appears,
3 On the Delivery Manager Configuration dialog, select the tab for the endpoint you 

want to configure.
4 In the endpoint configuration tab, uncheck Group Mono Tracks.

[

5 Click Save, then Close.
6 Restart the Delivery Manager service.

Including Language Metadata on Import
By default, Delivery Manager ignores any language audio program labels contained within the 
metadata of video and voice over media. This option can be enabled or disabled within the 
Delivery Manager endpoint configuration, Once changed, this configuration will only affect 
newly imported media.

To include language metadata in Delivery Manager:
1 From Windows, click START > All Programs > iTX 2.0 > Delivery Manager Config. 
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The Select Configuration dialog is displayed.
2 Select a configuration profile and click OK.

The Delivery Manager Configuration dialog appears,
3 On the Delivery Manager Configuration dialog, select the tab for the endpoint you 

want to configure.
4 In the endpoint configuration tab, uncheck Ignore Language Metadata.

[

5 Click Save, then Close.
6 Restart the Delivery Manager service.

Editing Audio Program Labels
The audio program labels that are currently stored in the iTX Opus database can be viewed, 
selected and edited from the Audio tab of the Output Server 2 Configuration user interface. 
If the labels are not in use, they can also be edited and deleted. The labels are stored 
centrally and therefore changes you make on one playout channel are available on all of the 
other playout channels in the same iTX domain.

Labels that are currently in use cannot be edited. This is indicated by a closed padlock icon 
.

To edit the list of audio program labels:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears.

2 Select the Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

3 In the Audio Programs section, click Available Labels.
A list of all of the available labels appears. This includes those created when media was 
registered (e.g. P#1, P#2, P#2, etc) and user created labels. If languages were defined in 
an Asset’s metadata, they are also displayed, for example ENG#1, ENG#2, FRA#1, etc.

4 You can edit the list of audio program labels in the following ways:
• To edit a label (that is not in use), double-click on its entry in the list and type the 

required amendment.
• To add a label, click in the blank box at the bottom of the list, type in a name, then 

press the Enter key.
103



Maintaining an Output Server 2 System
Editing Audio Programs and Rules
• To delete an existing entry (that is not in use), select it and press the Delete key.
5 Click Save to store your changes and automatically reboot the Output Server 2 service. 

Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Editing Audio Programs and Rules
All of the configuration for existing audio programs can be altered, including the mapping 
rules, or they can be deleted altogether.

To edit an audio program:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Select the Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

3 In the Audio Programs section, an existing Audio Program substitution rule can be 
edited in the following ways:

a To rename a rule, double-click on its Name cell and type the new name.
b To delete a label from the rules, select the label in the Rule cell and press the Delete 

key.
c To change the Dolby metadata configuration, click Edit in the Dolby column.

The popup Dolby dialog appears. See Configuring Dolby Metadata on page 57.
d To change the output channel, select an alternative from the Output Channels 

drop-down list.
When you select a different output channel type, a pop-up message appears 
asking if you would like to change the Dolby configuration to defaults that are 
appropriate for the output type.
Click Yes to change your Dolby configuration to sensible defaults or No to leave the 
Dolby configuration as is.

e To change whether the scheduled voice over is applied to the audio program, 
check or uncheck Apply VO.

f To delete an audio program, click  at the end of the row.
4 Click Save to store your changes and automatically reboot the Output Server 2 service. 
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Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Editing Audio Output Program Groups
An audio output program group can be edited by changing its audio type, changing the 
rules assigned to it or by deleting it altogether.

To edit an audio output program group:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Select the Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

3 In the Audio Output Program Groups section, select an output target tab, either SDI or 
IP.

4 An existing output group can be edited in the following ways:
• To change the audio type, select an alternative from the Type drop-down list.
• To delete a audio program from the output group, select the program in the 

Programs cell: 

Press the Delete key.
• To delete an output group, click  at the end of the row.

5 Click Save to store your changes and automatically reboot the Output Server 2 service. 
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Honoring NTSC SD Field Orders
In an Output Server 1 system, the field order for NTSC SD assets often had to be reversed on 
a per-asset basis for video to playout as expected. This was done by checking the Reverse 
Field Order checkbox on the Asset tab of the Asset layout in iTX Desktop. Output Server 2 is 
able to interpret the field order from the media itself. As such, Output Server 2 defaults to 
ignoring the Reverse Field Order checkbox and plays out the asset as the media dictates.

Note: If the combination of the selected audio program’s output channel 
and the output group’s audio type are incompatible, the Program cell turns 
red and the Description cell displays an error, explaining why the selected 
combination cannot be used together.

To correct this error, change either the output group’s audio type or the 
selected audio programs.
105



Maintaining an Output Server 2 System
Maintaining Custom Aspect Ratio Control (ARC) Modes
If you are operating a mixed Output Server system, you may not want Output Server 2 
playout servers to ignore assets with reversed field orders. This can be controlled using a 
global configuration called OS2 Ignore “Reverse Field Order”. If this option is set 
incorrectly for you system, your NTSC SD assets it may play out incorrectly (juddering or 
shaking).

To configure OS2 to honor Reverse Field Order:
1 On a playout server that is running Output Server 2, start the iTX Desktop client.
2 Log in with a system administrator profile.
3 Open the Engineering layout.
4 Click Channel Config. 

The Channel Config pop-up layout appears.
5 Click the System Wide Config tab. 
6 The OS2 Ignore “Reverse Field Order” field is enabled (lit green) by default.

Click OS2 Ignore “Reverse Field Order” to disable it.
7 Click Close. 
8 The Channel Config pop-up layout closes.

Maintaining Custom Aspect Ratio Control (ARC) Modes
Custom ARC modes are stored in the iTX database, so when one is created it is available to 
all channels within the same iTX domain. As such, editing or deleting a custom ARC mode 
affects all of the channels using it.

Editing a custom ARC mode

To edit a custom Aspect Ratio Control mode:
1 Open the iTX Desktop and click the Engineering layout.
2 Click Channel Config. 

The Channel Config pop-up layout appears.

Note: For Output Server 2, a video asset’s detected field order can be seen 
in the Field Order field on the Locations tab in the Asset layout of iTX 
Desktop.

Note: Custom ARC modes can be edited at any time and the very next 
scheduled item to be played out with matching field values will have its ARC 
operation and AFD code changed accordingly. This includes those in 
schedules on other channels that use the same custom ARC mode.
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3 From the View list, select the view containing the channels to be configured. The 
channels associated with that view appear.

4 Click the name of the channel to be configured.
5 Click the Channel Config 4 tab.
6 In the Advanced Aspect Ratio Control panel, click Configure Mapping...

The Advanced Aspect Ratio Control - Mapping Configuration dialog appears.
7 In the Advanced Aspect Ratio Control - Mapping Configuration dialog, click Select.... 

The Select Item dialog appears.
8 Select the ARC mode to be edited then click OK.

The select custom ARC mode and its settings appears.
9 Modify the Input and Output Aspect Ratio, size and position as required. For more 

information see To remove the previous baseline subtitle configuration for legacy 
subtitles:, on page 75.

10 When you have finished making changes, click Save. 
11 Click Close. 

You are returned to the Advanced Aspect Ratio Control - Mapping Configuration 
dialog.

Deleting a custom ARC mode
It is possible to delete a custom ARC mode from any iTX channel. If the deleted custom ARC 
is still in use (either on the selected channel or any other channel), iTX will automatically 
restore it.

To delete a custom Aspect Ratio Control mode:
1 Open the iTX Desktop and click the Engineering layout.
2 Click Channel Config. 

The Channel Config pop-up layout appears.
3 From the View list, select the view containing the channels to be configured. The 

channels associated with that view appear.
4 Click the name of the channel to be configured.
5 Click the Channel Config 4 tab.
6 In the Advanced Aspect Ratio Control panel, click Configure Mapping...

The Advanced Aspect Ratio Control - Mapping Configuration dialog appears.
7 In the Advanced Aspect Ratio Control - Mapping Configuration dialog, click Select.... 

The Select Item dialog appears.
8 Select the ARC mode to be deleted then click OK.

The select custom ARC mode and its settings appears.
9 Click Delete. 

The item is deleted with no further confirmation or prompts and the first custom ARC 
in the select list is displayed.

10 Click Close. 
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You are returned to the Advanced Aspect Ratio Control - Mapping Configuration 
dialog.

11 Click OK to close the Advanced Aspect Ratio Control - Mapping Configuration dialog.

About Restored Custom ARC Modes
If the custom ARC mode was assigned to a channel, it is not removed from the iTX database.

When the Advanced Aspect Ratio Control - Mapping Configuration dialog is next accessed 
from a channel using a deleted custom ARC, a warning will appear to say the deleted 
custom ARC mode has been restored.

If a new custom ARC is created with the same name as a deleted custom ARC, when the 
deleted one is restored, its name is appended with a dash then a number. e.g. a custom ARC 
mode called example_custom_arc would be restored as example_custom_arc-1.

To permanently delete a custom ARC mode, it must be unassigned on every channel that is 
using it before being deleted.

Deleting a Channel
Channels can be deleted from the ITX Channel Config dialog of TXPlay 2 Config.

To delete a channel:
1 On the Windows desktop of the playout server, double-click on the TXPlay 2 Config 

icon. The ITX Channel Config dialog appears.
2 If there is more than one channel configured on the playout server, select the channel 

to be deleted from the Channel Name drop-down list.
3 Click Delete Channel. 

The channel disappears from TXPlay 2 Config.
4 Click Save to confirm the deletion.

Configuring Server Controller for Output Server 2 Components
Under normal operating conditions, the Service Controller configuration for each iTX 
service is updated and maintained by modifying their respective configuration utility. For 
example, the running the TXPlay2 Config utility defines the Server Controller arguments for 
Output Server and I/O Device Controller. However, sometimes it is necessary to make 
changes to the way a service runs by changing the Server Controller configuration directly. 

IMPORTANT
• You must make sure you stop the instances of TXPlay 2 and Output Server 

2 associated with the channel to be deleted before you begin. 
• Deleting a channel from an playout server does not remove it from any 

views in iTX Desktop.
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Server Controller Configuration for the I/O Device Controller
To edit the Server Controller configuration for I/O Device Controller:

1 From Windows, click Start > All Programs > iTX2.0 > Server Controller Config. 
The Server Controller Configuration dialog appears.

2 Go to the Services tab.
3 Select the I/O Device Controller service then click Edit. 

The Service Details dialog appears.

4 Make sure Enabled is checked. This will run the instance of the service when Server 
Controller is started.

5 In the Arguments field, the following arguments are available:

6 Make sure Auto Restart is checked. This ensure Server Controller automatically 
restarts the I/O Device Controller service in the event of a failure. 

Server Controller Configuration for Output Server 2
To edit the Server Controller configuration for an Output Server 2 channel:

1 From Windows, click Start > All Programs > iTX2.0 > Server Controller Config. 
The Server Controller Configuration dialog appears.

2 Go to the Services tab.

Argument Description

-config SingleChannel Single input, single output channel.

-config SingleChannel4K Four inputs, four outputs for a single channel.

-config DualChannel Two independent channels, each with a single input 

-config DualLive Single channel with two inputs

-config Simulcast Two channels sharing two inputs 
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3 Select the Output Server 2 service then click Edit. 
The Service Details dialog appears.

4 Make sure Enabled is checked. This will run the instance of the service when Server 
Controller is started.

5 In the Arguments field, the following arguments are available:

Argument Description Inclusion

-ui Enables the user interface, which is 
required to access Output Server 2’s 
Configuration and Engineering panels.

Required

-n <Name> Specifies the name of the service. For 
example, for a channel called "GV Movies 
1" you might enter: -n GVMovies1 (no 
spaces)
A user friendly alias for channel names 
can be created in iTX Desktop.

Required

-backup Used to indicate an instance is a backup 
service.

Optional

-t <Card type> Describes the type of video or audio card 
fitted in the host machine. In most cases 
this will say: -t AJAXena.

Required

-id <Letter> Used to identify the inputs/outputs on 
the video/audio I/O card being used for 
the channel. 
For example: -id A or -id B.

Required for:
• Corvid 44 
• Corvid 88
• Dual Corvid 

LPs
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6 Make sure Auto Restart is checked. This ensure Server Controller automatically 
restarts the Output Server 2 service in the event of a failure. 

Viewing the Output Server 2 Engineering Panel
Along with the Configuration panel, Output Server 2’s user interface includes an 
Engineering panel, which contains the following tabs:

• Status
• Event Log

For information on accessing the user interface, see Selecting the Channel Resolution and 
Frame Rate, on page 46.

About the Status tab
The Status tab shows the input status of the video/audio I/O card and information about the 
File Processing Pipeline. It also allows you to select the I/O Device and also adjust the audio 
synchronization for the current clip.

-p <plugin name> Identifies the media application 
framework plugin to be used with 
Output Server 2. 
Valid values include: 
• -p iTXPlayer2 (default value)
• -p Simulator (use for testing only)

Default

-ratefamily <framerate> Specifies the frame rate to use for the 
channel, overriding the valid specified in 
I/O Device Controller’s configuration. 
Valid values include:
• -ratefamily 50
• -ratefamily 59.94
• -ratefamily 24
• -ratefamily 23.98

Note:
• If you add or change this argument you will 

need to reselect the Resolution from the 
Output Server 2 user interface.See Selecting 
the Channel Resolution and Frame Rate on 
page 46.

• If the frame rate family specified in Output 
Server 2 does not match that of the I/O 
Device Controller, Output Server 2 will start 
up in an error state.

Optional

Argument Description Inclusion
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About the Event Log
The Event Log displays events sent from FPP to Output Server 2. This information can be 
used by GV Care to diagnose potential issues with either FPP or Output Server 2.

About Logging for Output Server 2

Log File Locations
The log files for an Output Server 2 channel and its related components can be found in the 
following locations:

Component Logs

Output Server 2 service Each messages sent from TXPlay 2 to OutputServer2 is logged as 
an individual XML file in the following location:
C:\ITXLogs\OutputServer\YYYY-MM-DD\*.xml

VyConsoleApp for FPP Each pooled VyConsoleApp process creates its own log file in the 
following location:
%APPDATA%\Miranda\VyConsoleApp_CHANNELNAME_SC_COM_
POOLID.log.*
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Custom logging profiles from iTX v2.8 onwards
For each iTX service there is a corresponding logging profile file. These are XML files that 
provide the service with parameters for how to collect and output logs. Although these 
logging profile files are distributed with default parameters, you can edit them to create 
custom logging profiles.

Each logging profile file has the same filename as the service it is for, followed by .logging. 
For example, OutputServer2.exe has a logging profile file called 
OutputServer2.exe.logging.

iTX v2.8 introduced 64-bit versions of Output Server 2 and I/O Device Controller, with 
executable filenames that end _x64.exe. If you have any existing custom logging profiles 
for either Output Server 2 or I/O Device Controller they will no longer work, as the 32-bit 
executables to which they refer are no longer active. 

To continue using your custom logging profiles for Output Server 2 or I/O Device Controller, 
you will need to copy their configuration from the old file to the 64-bit version. 

To copy a custom logging profile to the 64-bit version:
1 On the Appliance Server running Output Server 2, open Windows Explorer.
2 Navigate to the Services folder for the iTX installation, e.g. C:\Program Files 

(x86)\Services.

3 To update the logging profile for the 64-bit Output Server 2:
a Open the folder OutputServer2.
b Open OutputServer2.exe.logging in a text editor, then copy and paste its 

contents into OutputServer2_x64.exe.logging.
c Save OutputServer2_x64.exe.logging and close the text editor.

4 To update the logging profiles for the 64-bit I/O Device Controller:
a Open the folder DeviceController.

VyCOMScheduler for FPP - 
Engineering logs

The engineering logs are written to the following location:
%APPDATA%\Miranda\VyCOMScheduler\VyCOMScheduler_CH
ANNELNAME.log
This file will roll over when it reaches about 10 MiB and up to 5 
rolled over files are kept.

VyCOMScheduler for FPP - 
Command logs

All commands that VyCOMScheduler receives are logged as 
executable powershell scripts.
%APPDATA%\Miranda\VyCOMScheduler\SchedulerCommandL
og.ps1.*
This file will roll over when it reaches about 10 MiB and up to 5 
rolled over files are kept.

Note: These scripts must be provided when reporting an issue 
since it tells Grass Valley Support exactly what Output Server 2 
received and when, and allows Grass Valley Support to replay the 
commands.

Component Logs
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b Open DeviceController.exe.logging in a text editor, then copy and paste its 
contents intoDeviceController_x64.exe.logging.

c Save DeviceController_x64.exe.logging and close the text editor.
5 Using Server Controller, restart the Output Server 2 and/or I/O Device Controller 

service(s) to pick up the changes to the logging configuration.
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Grass Valley Technical Support
For technical assistance, contact our international support center, at 
1-800-547-8949 (US and Canada) or +1 530 478 4148.

To obtain a local phone number for the support center nearest you, please consult the 
Contact Us section of Grass Valley’s web site (www.grassvalley.com).

An online form for e-mail contact is also available from the web site.

Corporate Head Office
Grass Valley
3499 Douglas-B.-Floreani
St-Laurent, Quebec  H4S 2C6
Canada
Telephone: +1 514 333 1772
Fax: +1 514 333 9828
www.grassvalley.com
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